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1. Installation 

Introduction 

Conf Pack is delivered on the Software Package CD-ROM. A set of 
installation diskettes can be generated from the CD-ROM to allow 
installation on PCs not equipped with CD-ROM drives. 

 
Protection 

When ordering this program, you were asked whether a hardware device (a 
dongle) or a software device (a license file) should be supplied for the im-
plementation of the software protection on your PC. 

Although more exacting than the hardware protection when first running 
Conf Pack (see the two procedures in page 1-5), the software protection 
should be preferred whenever the risk of losing dongles is real. Traveling 
users for example are advised to choose this option. On the other hand, 
dongles are better suited for sedentary users. 

In the absence of a protection device on your PC, you will still be allowed to 
run Conf Pack, but in this case only the DGNSS-related section of your 
configuration files will be accessible from the Select pane. In this particular 
way of using Conf Pack, long-time users of the Aquarius series will have 
recognized DSet Pack. As a matter of fact, DSet Pack is no longer provided 
with receivers from the Aquarius series as users continue to have the same 
tool at their disposal if they use Conf Pack without a protection. 

 
Computer requirements 

 Processor : DX2-66 minimum, Pentium recommended 
 RAM : 16 Mbytes minimum, 24 Mbytes recommended 
 Operating system : Windows 95, 98 or NT 
 Display screen : SVGA, 17 inches recommended 
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Installation procedure from the CD-ROM 

- Insert the CD-ROM into the drive 

 The Auto-start procedure presents a selection of software 
packages to be installed 

- Select Conf Pack and proceed with the installation as described 
in the next pages using diskettes. 

 

Installation procedure from a set of 3¼" disk-
ettes 

- Insert the first diskette into the PC drive 

- From the Windows taskbar, click Start 

- Select Run from the pop-up menu 

- In the text box which then appears, type: 

 

a:setup 

 

 and click the OK button (or press [Enter]). This causes the Setup 
program to be started from the diskette. This program will assist 
you through the entire installation procedure. 

 Below are the main stages in the installation. 

 

• Welcome Dialog box 
 As mentioned in this box, we recommend you to close all the 

active applications before proceeding with the installation. 
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• Registration 
- Specify the following in the two text boxes: 

• your name 

• your company's name 

 

• Destination directory 
- Specify the name of the target directory where you would like the 

software to be installed. You can specify a non-existing directory: 
the program will create it for you after confirmation. 

 

• Program folder 
- Specify the name of the folder where you would like the program 

shortcuts to be created. 

 

• Start copying files 
- Click the Next button to start installing the software (or click the 

Back button to come back to the installation parameters if you 
want to change any of them). 

- After you have clicked Next, insert the next diskette when 
prompted by the Setup program (step to be repeated until the 
files from all the diskettes have been installed). 

 

• End of installation 
- The end of installation is denoted by the message "Setup is 

complete". 
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• Program folders and shortcuts 
- After successful installation and using the explorer, the following 

is now visible on your disk: 
 

 
 Bin : Contains all the program files (mainly *.exe, 

*.dll, *.hlp, *.ocx, etc.) 

 Cfg : Default directory for the configuration files that 
you will create 

 Cmd : Default directory used to save all Win Comm 
command files 

 Raw : Default directory invoked when acquiring data 
records 

 Set : Default directory invoked when saving port set-
tings 

 Tpl : Default directory for the configuration templates 
that you will create 

- In addition, a new folder (the "program folder") is present in 
C:\WIN..\Start Menu\Programs\D.S.N.P., containing the shortcut 
below: 
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Running Conf Pack for the first time 

��If you chose the hardware protection option 
- Connect the dongle to the parallel port of your PC (the one usu-

ally used for printers). If a printer is already connected, insert the 
dongle between the printer cable and the PC connector. Then 
check that the printer is "on line". 

- Double-click on the Conf Pack icon to start the program. 

As long as the dongle remains present on the parallel port, Conf Pack will 
run normally every time you double-click on the Conf Pack icon. 

If you accidentally remove the dongle, or if you are not in possession of the 
dongle, the following will appear on the screen when you start Conf Pack: 

  
After clicking the OK button, you will be allowed to use Conf Pack in its 
“light” version (equivalent to former DSet Pack software) offering a set of 
modules reduced to the following: 

 
(This operation mode is precisely the desired one when for example you 
just have to set the DGNSS-related section of an Aquarius receiver) 
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��If you chose the software protection option 
After installing Conf Pack as described earlier, do the following: 

- Run Conf Pack. A warning message (same as on preceding 
page) informs you that only the “light” version of Conf Pack can 
be run  

- Click OK. The Conf Pack main window then opens. 

If you just want to work with the “light” version of Conf Pack, you can now 
start working on your configuration files. If you want to install the full version, 
do the following: 

- Select Tools>Unprotect 

- Check the using software protection method button. The 
dialog box then looks like this: 

  
- As prompted in the lower part of this dialog box, contact us so 

that we can generate a license file for you. This will be possible 
only after you have passed on your personal soft code to us (this 
code is also indicated in the above dialog box). 

 In the example above, this code is “983808” but yours will 
probably be a different one. 
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- After receiving the license file (filename: dsnp.lic) and installing it 
somewhere on your PC, come back to the Unprotect Software 
Component dialog box above and select this file using the 
Browse.. button so that the filename appears in the field on the 
left 

- Click the Go button. After successful installation, the following is 
displayed: 

  
- Click the OK button and then re-start Conf Pack in order to 

benefit from the full version. 

♣ 
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2. Introduction 

Configurations stored in GNSS receivers  

Three types of configurations are stored in a GNSS receiver: 

- Default configuration, resident in the firmware. This configura-
tion cannot be modified. It resets all parameters in the unit to 
known values (operating mode, serial port configuration, output 
messages, etc.) 

- Initial configuration, saved in a non-volatile memory. It can be 
modified using Conf Pack. It contains the necessary parameter 
settings for the reference configuration of an application or for 
any particular operating mode (mobile, reference station, etc.). 

- Current configuration, saved in a non-volatile memory. This con-
figuration is modified by the operator's actions (through 
commands). 

With Aquarius or Scorpio units, the Default configuration can be loaded in 
place of the current configuration by pressing the push-button on the 
integrated display and holding it depressed, at power-on, or by sending the 
following command : $PDAS, CONFIG,RESET. 

The command $PDAS,CONFIG,INIT can be used to load the Initial 
configuration in place of the current configuration. 

The command $PDAS,CONFIG,LOAD can be used to load a configuration 
file from a PCMCIA to a receiver unit to become its new initial and current 
configurations. 
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Introduction to Conf Pack 

- Conf Pack is designed to help you create the configuration files 
needed to operate your GNSS receivers. 

- Conf Pack is the only tool required for your configuration 
operations, whether your receivers are used in land or marine 
applications, at reference stations or in mobile receivers. 

- Some configuration parameters being interdependent, Conf Pack 
will force the selection or deselection of some of them following 
your own selections or deselections. 

- Conf Pack does not show the configuration file under its final 
aspect (i.e. a list of command lines executable in receivers) but 
instead provides a more user-friendly view, using three 
different panes, from which you can more easily create or 
modify the file. The resulting file can however be viewed using 
the Print Preview command from the File menu. 

- Conf Pack lets you open several files concurrently if necessary. 
This feature allows you for example to overwrite an open file 
with the content of another open file. 

- For effortless entry of such navigation parameters as waypoints, 
routes and beacons, Conf Pack lets you define these parameters 
through a simple click of the mouse on a map of your work 
region (conventional entry from the keyboard remains possible 
however). Waypoints can also be created by importing points 
from the 3SPack software. 
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- Conf Pack lets you write the scripts of your display screens 
and output messages according to a syntax specific to Conf 
Pack. 

- Conf Pack also includes a communication tool so that, among 
other things, configuration files can be directly loaded into or 
read from your receivers. 

 When creating a new configuration file, you should constantly 
keep in mind the nature of the target receiver, and so define only 
those parameters relevant to this receiver. For example, do not 
define anything in the SCREEN module if you use the receiver as 
a black box, etc. 

 
How a configuration file is shown with Conf Pack 

- When opening a configuration file with Conf Pack, a new window 
appears describing the file content through three distinct Panes 
(Select, Edit and Graphic), as illustrated below. 

- These three panes have been designed so that you can work 
more easily on your configuration files (see illustration below). 
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• Select Pane: 
- Used to select/unselect parameter modules and sub-modules so 

that they be included or not in the configuration file currently cre-
ated or modified. The Select Pane will automatically force the 
selection or deselection of parameters for those dependent on 
the presence or absence of others. Some sub-modules of pa-
rameters are necessarily part of any configuration you design. 

- Also provides viewing options for each module (sub-modules can 
be shown or hidden by a simple click of the mouse). 

 

• Edit Pane: 
- Shows the Editor table corresponding to the parameter sub-

module you select. 

- The number of columns in the Editor table is specific to the 
selected sub-module. 

- The number of rows depends on the number of entries you make 
for this sub-module. 

- The Edit Pane is updated whenever you click the document icon 
of a sub-module, whether selected or not, in the Select Pane. If 
the sub-module corresponding to the clicked icon is not currently 
selected, then the Edit Pane will turn blank. 
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• Graphic Pane: 
- Shows the entries you make in the Edit Pane in a more synthetic, 

user-friendly way (not an entry pane). 

- In the case of the Navigation and DGNSS modules however, 
this pane operates as a graphic editor as any click of the mouse 
in this pane will be translated directly into an alpha-numerical 
entry (a waypoint, a route or a beacon) in the Edit pane. 

 

• Re-sizing the 3 panes of the Conf Pack main window 
- Position the pointer inside the main window, on either a vertical 

or horizontal pane border. This causes the pointer to change 
shape: 

  if the pointer is on a vertical border, 

 or 

  if the pointer is on a horizontal border 

- Using the left mouse button, drag the border to the desired 
location 

- When you reach this location, release the mouse. This causes 
the three panes to be re-sized accordingly. 
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��Using the Select Pane 
The Select Pane shows the eight possible modules of parameters which 
can be part of a configuration file. 

 
 

Handling the Select Pane is much similar to working with Windows 95 
explorer. For each parameter module: 

- The leftmost '+/-' button is used to show/hide all the sub-modules 
of a module: 

  : sub-modules shown (book open) 

  : sub-modules hidden (book close) 

 

- The check button right-adjacent to the '+/-' button is used to se-
lect the module in order that it be part of the configuration file 
being created. Some of the modules cannot be unselected: 

  : button checked: module selected 

  : button cleared: module unselected 

  : button turns gray when checked: only part of 
the sub-modules are currently selected 
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- The check button left-adjacent to a sub-module name is used to 
select that sub-module in order that it be part of the configuration 
file being created: 

  : button checked: sub-module selected 

   Clicking the document icon will cause the 
Editor table corresponding to that sub-module 
to appear in the Edit Pane. 

  : button cleared: sub-module unselected 

   Clicking the document icon will cause the Edit 
Pane to turn blank. 

 

��Using the Edit Pane 
The Editor Pane shows the Editor table. 

The Editor table consists of a top row (in gray), a Status column (leftmost 
column in gray) and a variable number of editable or non-editable cells ar-
ranged in rows and columns (data rows and columns). 
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• Cell types 
- There are 4 different types of cells: 

 Combo cells : Only the options from the combo box can be 
selected to be inserted into this type of cell 

      
 

 Text cells : Can contain a limited number of alpha-
numerical characters 

      
 

 Numeral cells : Can only contain numerical values (with 
delimited range) 

      
 

 Software-set cells : Controlled by Conf Pack 
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- Whenever the content of a cell is irrelevant to the current context, 
then the cell is locked (no data entry possible). 

 
• Re-sizing the editor table 

Re-sizing rows: 

- Position the pointer on the bottom border of any cell in the status 
column (leftmost gray column). The pointer shape then looks like 

this:  

- Using the left mouse button, drag the pointer downward to 
increase the row height, or upward to decrease it 

- Release the mouse button when you get the desired height. 

 Note that all other rows, if any, in the Editor table, are also 
resized according to your new setting. 

 Note also that re-sizing the Editor table rows from any sub-
module will also affect the Editor Table of all other modules and 
sub-modules 

 
Re-sizing a column: 

- Move the pointer into the in the header (top gray cell) of the 
column you want to re-size and position the pointer on the right-
hand border of this cell. The pointer shape then looks like this: 

 
- Using the left mouse button, drag the pointer to the right to 

enlarge the column, or to the left to narrow it 

- Release the mouse button when you obtain the desired width. 
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• Editing instructions 
- To move the cursor from cell to cell within the Editor table, use 

any of the 4 arrow keys. Alternately, you can use the tab key for 
horizontal forward jump, or the Shift+Tab keys for horizontal 
backward jump 

- The Status column can contain the following symbols: 

   indicates that a cell is selected somewhere in 
this row 

   denotes an editing operation in progress 
somewhere in the row 

   denotes the last row of the Editor table 
(necessarily an empty row). Unless you have 
created the last row possible in the table, this 
symbol will disappear as soon as you enter a 
single character anywhere in the row. A new 
empty row will then be created with this symbol 
in the first cell. 

- The pointer will take the following shape if you move it on any cell 
(except the top cell) in the Status column: 

   which means that you will select the entire row 
if you then click the left mouse button. This is 
useful when for example you want to delete the 
definition of a waypoint, a route or a coordinate 
system. In this case you just need to select the 
corresponding row and then depress the Delete 
key. 
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- When the definition of a row is finished, simply press the Enter 
key to stop editing. 

 

��Using the Graphic Pane 
- In most cases, the Graphic Pane will just display a summary of 

all the choices you have made in the selected sub-module. For 
example, choosing an elevation angle of 5 ° will be illustrated as 
follows in the Graphic Pane: 

 

  
- The Graphic pane also provides an immediate simulation of the 

formats you have written whenever they are the subject of the 
Edit Pane, i.e. when either of the following sub-modules is se-
lected: 

. Formats, Computed data (INPUT / OUTPUT 
module) 

. Presentation (SCREEN module) 

 
- The Graphic Pane can also be used as an input device to define 

waypoints, routes and beacons. 
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��Changing the Options of Conf Pack 

- In the toolbar, click   or from the menu bar, select Tool and 
then Options. A dialog box appears in which you can set the 
options of the process: 

 
 

General tab 

 

 Timeout : Maximum time allowed for a receiver to send an ac-
knowledge to Conf Pack. At the end of this time, if no 
connection is made, Conf Pack will cancel the opera-
tion in progress. 

 

 Screen Type : Defines the screen size of your receiver(s), as shown 
on the Graphic Pane when selecting the Appearance 
sub-module (from the SCREEN module) 

 Line : Number of lines on the screen 

 Column : Number of characters in a line 

 Auto Line Feed : If checked, this option will terminate a too long 
character string at the end of a line and will 
place the extra characters on the next line 
(beneath). 

   If cleared, this option will let the character string 
extend beyond the end of the line. Extra 
characters, if any, will therefore be invisible on 
the receiver screen. 
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Communications tab 
 

  
 

• Performs automatic settings of the serial port connected to a 
THALES receiver or lets you enter these settings manually: 

 Assuming a receiver is connected to your computer through a 
serial port: 

 Automatic: 

- Click the Auto Configure button to initiate an 
automatic search for the Baud rate. Use this button if 
you are not sure about the Baud rate. 

- An automatic search for the Baud rate is only allowed 
with THALES receivers as this requires that the 
receiver be capable of returning a consistent reply to a 
proprietary command. 
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 After choosing Auto Configure you are allowed to: 

- disable the communication by clicking "Cancel" 

- or, if the identification is successful, close the 
Communication Settings dialog box, by clicking OK. 
This enables communications between the computer 
and the GPS receiver and allows you to transfer 
configuration files to the receiver. 

 

 Manual 

- Enter the following communication parameters  

- Serial port No. 

- Baud rate 

- number of bits per character 

- parity check option 

- number of stop bits 

- Click the OK button. 
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• Allows you to save/restore port settings: 

 Saving port settings: 

- Click the Save settings button. This opens a dialog 
box that allows you to save the serial port 
configuration currently enabled so that you can quickly 
retrieve it at a later date using the Load Settings 
push-button. 

- In the File Name text box, enter a name for the file to 
which the serial port configuration should be saved 
(typically with '.set' as extension). Typically, serial port 
configuration parameters are saved to the 'set' 
directory. 

- Click the Save button to save the following 
communication parameters  

- serial port No. 

- Baud rate 

- number of bits per character 

- parity check option 

- number of stop bits 

- Clicking Cancel would take you back to the 
Communication Settings dialog box without saving 
any settings. 
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 Restoring port settings 

- Click the Load settings button. This opens a dialog 
box that allows you to select any serial port 
configuration file saved earlier using the Save 
Settings button. 

- Click the desired file name in the list box, to select it 
(typically in the 'set' directory), and click Open. As a 
result the serial port parameters in the 
Communication Settings dialog box are 
automatically set as specified in the file you selected. 

- Clicking Cancel would take you back to the 
Communication Settings dialog box without loading 
any settings. 

 

 

Variables tab 

- User-set values arbitrarily assigned to variables in Conf Pack. 
These variables are in fact those handled by a GNSS receiver in 
operation (L84, G84, H84, etc.) 

- In Conf Pack these arbitrary values are used by the Graphic 
Pane to simulate screens or messages whenever the variables 
are invoked by the Editor Pane. ♣ 
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3. Creating files with Conf Pack 

Creating a new configuration file 

- In the Toolbar, click   

 or 

 from the menu bar, select File and then New 

- In the New dialog box which then appears, select any line 
containing “Configuration File” or “Configuration File (...)” and 
click OK 

 or double-click directly on this line. For more information on the 
bracketed term, see page 3-3. 

- A new window appears showing a copy of the file selected earlier 
in the New dialog box. As shown in the title bar, the file is given 
the default name “Config1” (or “Confign” if “n-1” files have been 
created in the current ConfPack session). 

 The file is unsaved, which means that you will have to confirm or 
change this name whether you select File and Save, or File and 
Save As, after defining the content of the file. 

- Select and view the desired modules and sub-modules of 
parameters as described in Using the Select Pane. 

- Define all your parameters. Refer to section 5 for more 
information on these parameters. 
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- To save your file, in the toolbar, click  

 or from the menu bar, select File and then Save 

- In the Save As dialog box which then appears, confirm or 
change the file name. The default extension is cfg, which we 
recommend to keep, and the default directory is Cfg (parent 
directory: ConfPack). 

- Click the Save button to complete the operation or Cancel to 
discard it. 

 

Creating a new configuration template 

In its content, a template file does not differ from a configuration file. The 
only difference resides in the fact that a template is prompted as a possible 
model for a new configuration, which cannot be the case with a “simple” 
configuration file (although you can create a new file, using the Save As 
command, from the currently displayed and active configuration file). 

- In the Toolbar, click    or select File from the menu bar and 
then New 

- In the New dialog box which then appears, select “Template File” 
and click OK (or double-click directly on this line). 

- A new window appears showing a copy of the file selected earlier 
in the New dialog box. As shown in the title bar, the file is given 
the default name “Templ1” (or “Templn” if “n-1” files have been 
created in the current ConfPack session). 
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 The file is unsaved, which means that you will have to confirm or 
change this name whether you select File and Save, or File and 
Save As, after defining the content of the file. 

- Select and view the desired modules and sub-modules of 
parameters as described in Using the Select Pane. 

- Define all your parameters. Refer to section 5 for more 
information on these parameters. 

- To save your file, in the toolbar, click   or select File from the 
menu bar and then Save 

- In the Save As dialog box which then appears, confirm or 
change the file name. The default extension is tpl, which you 
should not change, and the default directory is Tpl (parent 
directory: ConfPack). 

- Click the Save button to complete the operation or Cancel to 
discard it. 

 The name that you give to your template will appear between 
brackets in the New dialog box when you next use it. 

 

About templates 

Templates are used when you create a new file. When you select File from 
the main menu, and then New, the New dialog box which then appears lists 
a number of lines referring to templates, as explained below. 
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After you choose a line from the New dialog box and you click the OK 
button, a copy of the corresponding template appears in the Conf Pack 
main window from which you can create your configuration. 

 
��How to create a new template 

You can create a new template only from the “Template file” line (default 
template) shown in the New dialog box. See procedure in Creating a new 
configuration template (see page 3-2). 

 
��How to remove a template from the New dialog box 

Using Windows 95 explorer, list the content of the Tpl directory (parent di-
rectory: ConfPack). Move the unwanted templates elsewhere or delete 
them. 

Note that the default template (“Template file” in the New dialog box) cannot 
be removed as it is required to create new templates. 
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Copying all the data from an open configuration 
file to another open file 

Assuming the two configuration files are open, do the following: 

- Click the left mouse button anywhere within the Select Pane of 
the source file 

- In the toolbar, click  

- Move the mouse pointer to the Select Pane of the target file and 
click the left mouse button anywhere within this pane 

- In the toolbar, click . A message box appears asking you to 
confirm the copy operation. 

- Click the Yes button if you really want to overwrite the entire 
target file with the data from the source file. 

 

Defining waypoints and routes with a simple 
click of the mouse 

- When you first select the Waypoints or Routes sub-module (by 
clicking the corresponding document icon in the Select Pane), 
the Graphic Pane is changed into a map centered around the 
point 0° 0' 0.000"N - 0° 0' 0.000" E (WGS84 coordinate system 
used necessarily). 

 A grid is represented, adapted to the size of the Graphic Pane. 
The map is magnified with the maximum zoom-in ratio possible. 
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 The coordinates of the mouse pointer, as you move it within the 
pane, are reported in white, with red background, in the upper-
right corner of the map. 

 

  
 

- A Shortcut menu is available from within this pane through which 
you can perform the following operations (described in detail in 
the next pages): 

. Defining the region where to place your waypoints 
using the World Map editor 

. Zooming in, zooming out 

. Moving the map within the Graphic pane 

. Adjusting the Zoom so as to view all the waypoints 

. Placing waypoints on the map 

. Importing waypoints from the 3SPack software 

. Defining routes on the map 

 

��Defining the region where to place your waypoints us-
ing the World Map editor 
See page 3-17. 
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��Zooming in 
- Position the mouse pointer anywhere on the Graphic Pane. 

- Click with the right mouse button. The shortcut menu pops up. 

- Choose the Zoom In command from the menu. As a result the 
menu vanishes and the pointer looks like  . 

- Position the pointer somewhere on the region on which you want 
to zoom in and click with the left mouse button. As a result the 
window displays a magnified view of the region, centered around 
the clicked point 

- You can zoom in repeatedly (i.e. so long as the mouse pointer 
looks like  ). The buzzer will sound if you try to zoom in and 
you have already reached the maximum zoom-in ratio. 

 
��Zooming out 

- Position the mouse pointer anywhere on the Graphic Pane. 

- Click with the right mouse button. The shortcut menu pops up. 

- Choose the Zoom Out command from this menu. As a result the 
menu vanishes and the pointer looks like  . 

- Position the pointer somewhere on the region and click with the 
left mouse button. As a result the window displays a larger-scale 
view centered around the region 
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- You can zoom out repeatedly (i.e. so long as the mouse pointer 
looks like  ).The buzzer will sound if you try to zoom out and 
you have already reached the minimum zoom-out ratio. 

 

��Moving the map within the Graphic pane 
- Position the mouse pointer anywhere on the Graphic Pane. 

- Click with the right mouse button. The shortcut menu pops up. 

- Choose the Grabber command from this shortcut menu. As a 

result the menu vanishes and the pointer looks like  . 

- Depress the left mouse button and drag the pointer in the 
direction where you want the map to be moved. Note that the 
move will take place only when you release the mouse button 
and it will be proportional to the distance covered by the pointer 
when you drag it. 

 

��Adjusting the Zoom so as to view all the waypoints 
- Select the Zoom to Fit command from the Shortcut menu. This 

causes the map to be re-adjusted (through a zoom-and-grab 
operation) so that it can view all the waypoints you have defined. 

- The Zoom to Fit command is executed automatically whenever 
corrections are made to the Editor table of the Waypoints sub-
module 
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��Placing waypoints on the map 
- Position the mouse pointer anywhere on the Graphic Pane. 

- Click with the right mouse button. In the shortcut menu which 
then appears, choose the Draw command. 

 As a result the menu vanishes and the pointer shape is changed 

to . 

- Watching the pointer coordinates displayed in the upper-right 
corner of the Graphic pane, position the pointer where you want 
a new waypoint to be created and click with the left mouse 
button. 

 As a result, a waypoint is created at this location: a flag is placed 
to indicate its location and a default name (WayPt nn) is assigned 
to it. 

 
 What's more, a new row is created at the bottom of the Editor 

table (Edit Pane) containing the definition of that new waypoint, 
expressed in the Default coordinate system. 

  

• Notes: 
- Subsequent modifications to a waypoint defined graphically will 

be possible only from the corresponding row in the Editor table 
(and the Graphic Pane will then be updated accordingly). 
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- Following any correction to the definition of a waypoint in the Edi-
tor table, the Graphic Pane is refreshed and the Zoom to Fit 
command is executed automatically. 

- When deleting a waypoint named 'WayPt nn' from the Editor ta-
ble, then all the next waypoints also named 'WayPt nn' are re-
numbered accordingly. 

- You cannot delete a waypoint if it is involved in the Navigation 
mode or in the definition of a route. 

 
��Importing waypoints from the 3SPack software 

This command can be used only if 3SPack has been installed on your com-
puter (otherwise the command in the shortcut menu is dimmed). 

- Position the mouse pointer anywhere on the Graphic Pane, click 
with the right mouse button and choose the Import from 
3SPack... command. 

 A dialog box appears listing the names of all the points available 
from 3SPack. Example: 
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- Choose one or more of the prompted points (combining the Shift 
or Ctrl key with a click on the mouse) and then click the Import 
button. 

 This causes the points to be added both in the Editor table and 
on the Graphic Pane. The Zoom to Fit command is then 
automatically run in order that the Graphic Pane can view all the 
points. 

 

��Defining routes on the map 
(after having created the necessary waypoints and after having selected the 
Routes sub-module from the Select Pane)) 

- Position the mouse pointer anywhere on the Graphic Pane, click 
with the right mouse button and choose the Draw command. 

 As a result the menu vanishes and the pointer shape is changed 
to . 

- Click successively with the left mouse button on all the waypoints 
making up the route. Proceed in chronological order, from the 
first to the last waypoint: 

- Click on the first waypoint. Conf Pack automatically assigns a 
default name to the new route (ROUTE nn), which appears 
beside this point with a software-set color.  

- Move the pointer to the next waypoint and click with the left 
mouse button again. Note the segment drawn from the previous 
waypoint as you move the pointer. Note also the attraction of the 
waypoint location if you do not click exactly on the cross (at the 
base of the flag). 
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- When arriving on the last waypoint, double-click on that waypoint 
to tell Conf Pack the route definition is complete (or double-click 
anywhere on the map, except on a waypoint, after clicking on the 
last waypoint of the route). 

 

 
 

 What's more, a new row is created at the bottom of the Editor 
table (Edit Pane) containing the complete definition of that new 
route 

 

    
• Notes: 

- Subsequent modifications to a route defined graphically will be 
possible only from the corresponding row in the Editor table (and 
the Graphic Pane will then be refreshed accordingly). 

- When deleting a route named 'ROUTE nn' from the Editor table, 
then all the next routes also named 'ROUTE nn' are re-numbered 
accordingly. 

- You cannot delete a route if it is involved in the Navigation mode. 



Creating files with Conf Pack 
Defining beacons with a simple click of the mouse 

 3-13 

 

Defining beacons with a simple click of the 
mouse 

- As this also happens with the Waypoints and Routes sub-
modules, when you first select the Beacons sub-module (by 
clicking the corresponding document icon in the Select Pane), 
the Graphic Pane is changed into a map centered around the 
point 0° 0' 0.000"N - 0° 0' 0.000" E (WGS84 coordinate system 
used necessarily). 

 A grid is represented, adapted to the size of the Graphic Pane. 
The map is magnified with the maximum zoom-in ratio possible. 

 The coordinates of the mouse pointer, as you move it within the 
pane, are reported in white, with red background, in the upper-
right corner of the map. 

 

  
 

- A Shortcut menu is available from within this pane, much similar 
to the one accessible from the Graphic Pane of the Waypoints 
or Routes sub-module. The same operations can be performed: 

- Defining the region where to place your beacons 
using the World Map editor: see page 3-17. 
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- Zooming in/out on the map: see page 3-7.  

- Moving the map within the Graphic pane: see page 
3-8. 

- Adjusting the zoom so that all the beacons can be 
viewed on the map: same as waypoints, see page 
3-8  

- Placing beacons on the map: see below. 

 

��Placing beacons on the map 
- Position the mouse pointer anywhere on the Graphic Pane, click 

with the right mouse button and choose the Draw command from 
the shortcut menu. 

 As a result the menu vanishes and the pointer shape is changed 

to . 

- Watching the pointer coordinates displayed in the upper-right 
corner of the Graphic pane, position the pointer where you want 
a new beacon to be created and click with the left mouse button. 



Creating files with Conf Pack 
Defining beacons with a simple click of the mouse 

 3-15 

 

 As a result, a beacon is created at this location: a milestone is 
placed to indicate its location and a default range (20 km is as-
signed to it, represented by a circle centered around that 
location. 

 
 What's more, a new row is created at the bottom of the Editor 

table (Edit Pane) containing the complete definition of that new 
beacon. Example (excerpt): 
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• Notes: 
- No default name is assigned to a beacon defined graphically. 

The corresponding field in the Editor table is left blank and a blue 
rectangle is shown above the milestone in the Graphic Pane (see 
above). You should therefore enter a name in the corresponding 
Name field (in the Editor table). 

- Also, in the same row, you will need to verify/change a number of 
parameters, such as transmission band, carrier frequency, 
modulation, encryption, etc, as these parameters are defined with 
defaults in the case of a beacon defined graphically. 

- Subsequent modifications to a beacon defined graphically will be 
possible only from the corresponding row in the Editor table (and 
the Graphic Pane will then be refreshed accordingly). 

- You cannot delete a beacon if it is involved anywhere in the 
Mode sub-module (DGNSS module). 
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Using the World Map Editor 

When from the Select Pane, you choose Waypoints or Routes 
(NAVIGATION module) or Beacons (DGNSS module), a shortcut menu is 
available from the Graphic Pane from which you can define the region of 
survey. This function uses the World Map editor described below. 

 

��Defining your work region using the World Map editor 
- Position the mouse pointer anywhere on the Graphic Pane, click 

the right mouse button to display the Map Shortcut menu and 
then select the Region... command. A new window appears 
showing the World Map editor. 

  
 A Shortcut menu is available from within this pane through which 

you can perform the following operations: 
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��Rotating the globe 
If the current view of the globe does not display the region where you would 
like to work in, a function is available allowing you to rotate the globe: 

- Position the mouse pointer anywhere on the pane of the World 
Map window. 

- Click the right mouse button. The World Map shortcut menu 
pops up. 

- Choose the Grabber command from this menu. The menu 

vanishes and the pointer looks like   

- Depress the left mouse button and drag the pointer in the 
direction where your region is. Note that the globe will rotate only 
when you release the mouse button. Note also that the rotation 
angle is defined by the distance covered by the pointer when you 
drag it. 

 
��Zooming in 

- Position the mouse pointer anywhere on the pane of the World 
Map window. 

- Click with the right mouse button. The World Map shortcut menu 
pops up. 

- Choose the Zoom In command from the menu. As a result the 
menu vanishes and the pointer looks like . 

- Position the pointer somewhere on the region on which you want 
to zoom in and click with the left mouse button. As a result the 
window displays a magnified view of the region, centered around 
the clicked point 



Creating files with Conf Pack 
Using the World Map Editor 

 3-19 

 

- You can zoom in repeatedly (i.e. so long as the mouse pointer 
looks like  ). Up to 6 successive zoom-in operations are possi-
ble from the initial view of the World Map. 

 

��Zooming out 
- Position the mouse pointer anywhere on the pane of the World 

Map window. 

- Click with the right mouse button. The World Map shortcut menu 
pops up. 

- Choose the Zoom Out command from this shortcut menu. As a 
result the menu vanishes and the pointer looks like  . 

- Position the pointer somewhere on the region and click with the 
left mouse button. As a result the window displays a larger-scale 
view centred around the region 

- You can zoom out repeatedly (i.e. so long as the mouse pointer 
looks like   ) until you reach the view of the entire globe. 
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��Selecting a region on the World Map 
Assuming the desired region is now visible on the World Map, after rotation 
and Zoom-in operations, do the following: 

- Choose the Draw command from the World Map shortcut menu 

- Drag the mouse button so as to surround the desired region. 
Release the mouse when you agree with the selection 

  
- Click the OK button. 

 On the Graphic pane which then displays again, note that that 
the graduations have been updated to comply with your choice. 
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��Changing the viewing options of the World Map 
- Position the mouse pointer anywhere on the pane of the World 

Map window. 

- Click with the right mouse button. The World Map shortcut menu 
pops up. 

- Choose the Options command from this shortcut menu. As a 
result the Options dialog box appears. The default options are 
shown below. 

  
 

Four levels of map resolution are available: 

- Low 

- Medium 

- High 

- Very High 

The higher the resolution, the more accurate the details on the map... but 
the longer the time required to display the map. 
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Viewing the resulting configuration file 

- Click the left mouse button anywhere within the Select Pane. 

- In the toolbar, click   

 or 

 from the menu bar, select File and then Print Preview. 

 The preview shows the current content of the configuration file (a 
list of command lines interpretable by THALES GNSS receivers). 

 

 Example (partial view): 

  
 

How to quit Conf Pack 

- From the menu bar, select File and then Exit. Unless an 
unsaved configuration is still open, this causes the Conf Pack 
main window to be closed immediately. 

 If one or more unsaved configurations are still open in the Conf 
Pack window, warning messages appear successively for each 
of these configurations asking you to save the last changes made 
to the file before quitting Conf Pack. Click the Yes button to save 
the last changes made, or the No button to discard them. ♣ 
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4. Using Conf Pack connected to a 
THALES GNSS receiver 

Preliminary steps 

Using one of the serial ports of your computer, Conf Pack can connect to a 
THALES GNSS receiver so that you can work on its configuration. 

You can also use the Win Comm tool to send commands to the receiver or 
to log data from the receiver. 

Prior to performing any of these functions, you should configure the PC se-
rial port properly, using the Communications tab in the Options dialog 
box. (see page 2-14). 

Then, and depending on what you intend to do, follow one of the proce-
dures described in the next pages. 

 

Before downloading or uploading a configuration file via one 
of the PC’s serial ports using ConfPack, do not forget to 
close the WinComm or Geoids window if these programs 
also use the same serial port. By doing this, you will make 
the port available to ConfPack. 

Remember the port settings may be specific to each utility 
program. For example WinComm may use port settings dif-
ferent from those requested by ConfPack. 
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Writing a configuration into a receiver 

• Direction of transfer: 
 

 

 

 

 

 

  

Assuming the receiver is properly connected and the serial line is properly 
configured: 

- Open the configuration file you want to write into the receiver 

- In the toolbar, click    or in the menu bar, select the Transfer 
menu and then Write Initial 

 A dialog box appears asking you to confirm the write operation. 

- Press the Yes button to start writing the active file into the re-
ceiver. A dialog box appears asking you to confirm or change the 
unit number assigned to the attached receiver. 

 After sending the file, Conf Pack waits for a transfer 
acknowledgment from the receiver. 

 If the acknowledge signal is returned in time, then the write op-
eration is considered to be successful (the transferred file is then 
the receiver's new initial and current configurations). 

 
Active 

configurati
on file 

 
 

Receiver 

Computer 
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 If no acknowledge signal is received, the write operation is 
aborted after the user-set time out (see page 2-13). 

 

Reading the currently used configuration from a 
receiver 

• Direction of transfer: 
 

 

 

 

 

 

  

Assuming the receiver is properly connected and the serial line is properly 
configured: 

- In the toolbar, click   or in the menu bar, select the Transfer 
menu and then Read Current 

 Conf Pack then starts reading the current configuration file from 
the receiver. A new window is opened in Conf Pack showing this 
file (default name: Confign). 

Read file 
becomes 
the active 

file in 
Conf Pack

 
 

Receiver 

Computer
Configuration currently used
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Reading the initial configuration from a receiver 

• Direction of transfer: 
 

 

 

 

 

 

  

Assuming the receiver is properly connected and the serial line is properly 
configured: 

- In the toolbar, click    or in the menu bar, select the Transfer 
menu and then Read Initial 

 Conf Pack then starts reading the initial configuration file from the 
receiver. A new window is opened in Conf Pack showing this file 
(default name: Confign). 

Read file 
becomes 
the active 

file in 
Conf Pack 

 
 

Receiver 

Computer 
Initial configuration 
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Sending commands to a receiver 

After connecting the receiver to the PC via the desired port, do the 
following: 

- In the toolbar, click    or in the menu bar, select Tools and 
then Win Comm. A new window is displayed showing the Com-
munication Settings dialog box. Use this box to set the PC port 
connected to the receiver: 

  

  
 
 There are three different ways of setting the PC port: 

- either manually by selecting the desired parameter in 
each of the fields shown in the above window 

- or by asking ConfPack to determine automatically which 
parameters should be used to communicate with the 
receiver. This is obtained by clicking on the Auto 
Configure button. After testing a number of combinations, 
ConfPack will finally position each of the fields so that 
communication can take place with the receiver  

- or by  loading a set of parameters which was saved earlier 
as a SET file (the Save Settings... button was then used 
for that purpose). This is simply obtained by first clicking 
on the Load Settings.. button and then choosing the de-
sired SET file. 
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- Once the fields are properly filled, click OK. The Win Comm dia-
log box then appears. For more information on the Display Pane, 
see page 4-16. 

 
- To send a command, use the Command Pane (upper-left): 

. Directly type the command in the upper combo box, or 
select it from that combo box, or fill that box by choosing 
the corresponding label from the lower combo box. 

. Click the Send button. 
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��Adding new commands to the combo box 
- Click the Advanced button in the Command Pane. The 

Commands Editor dialog box appears allowing you to set up a 
group of commands interpretable by the connected receiver. The 
commands you select in this dialog box will be prompted in the 
main window. (As a result, you will only need to choose the 
desired command from the list in the main window and click to 
send the command to the connected receiver). 

 

  
 

 The buttons in the Commands Editor dialog box allow you to 
load any command-group file available, make any change to the 
group and save your own command groups. 

 The selected command group will be available in the main win-
dow after you close the Commands Editor dialog box (by clicking 
in the upper-right corner). 
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��Using the Commands Editor dialog box 
 Group Label : Text box used to enter and/or view the name given 

to a command group. For example, this name can 
suggest the type of receiver connected when this 
command group should be used. 

 Command : Text box used to enter and/or view each command 
script. Use the associated scrollbar to browse 
through the list of available commands. 

 Label : Text box used to enter and/or view a plain label for 
each command script. Use the associated scrollbar 
to browse through the list of available commands. 

 Add command : Adds the command viewed in the text box to the list 
of available commands. 

 Delete command : Removes the command viewed in the text box from 
the list of available commands. 

 Load commands : Opens a dialog box that allows you to choose the 
appropriate command group file for the connected 
receiver so that the command group becomes avail-
able in the main window after you close the 
Commands Editor dialog box. 

 Save commands : Opens a dialog box that allows you to save your own 
command group (as viewed in the Commands Editor 
dialog box) (cmd extension). 

- Click  to close the Commands Editor dialog box. This loads 
the selected command group to the main window. 
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Logging data sent by the receiver 

Assuming the receiver is properly connected to the PC port: 

- In the toolbar, click    or in the menu bar, select Tools and 
then Win Comm. 

- In the window that appears, set the PC port as explained in page 
4-5 in order to allow communication with the receiver. 

- Press OK. A new window appears showing the Win Comm dia-
log box. For more information on the Display Pane, see page 4-
16. 

 As shown in the right-hand part of the window, there are two 
different ways of logging the data, depending on the type of 
receiver used: 

. simple recorder 

. programmable recorder. 
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��Simple GPS recorder 
All data output from the receiver's port is viewed in the main window's 
Display pane / window. The data can be recorded to the file specified in the 
File Name and Directory text boxes. 

When the Simple GPS Recorder option is activated, you start and stop the 
recording manually, by simply clicking the Start/Stop Recording button. 

 
 File Name : This text box is used to specify the name of the file to 

which you wish to record the data from the receiver. 

   Unless a maximum size is selected for the file, you are 
also allowed to enter an extension into the associated 
box. 

 File Max Size : This option box is used to specify whether a single file 
should be created on the disk (No Limits option) or 
the file should be split into 0.7 MB or 1.4 MB segments 
(with a view to storing it to floppy disks). 
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   If you elect to split the file into segments, then the sys-
tem will automatically add 001 as extension to the 
name of the first segment. This will automatically be 
incremented for each file segment generated, if the file 
exceeds the File Max Size selected. 

 Start Recording : Clicking this button causes the data to be recorded to 
the specified file until you click the button again. (The 
label of the button changes from Start Recording to 
Stop Recording). 
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��Programmable GPS recorder 
The Programmable GPS Recorder option allows you to prepare one or 
more requests for recording the data output on the connected receiver port, 
by specifying a start date, time and duration for each planned recording 
session, and also a disk file name, directory and maximum size. 

You can save the recording session requests you prepare (using the Save 
button) so that you can load them back at a later date (using the Load 
button). 

 
 Directory : This text box is used to specify the directory to which 

you wish to record the data from the receiver. Clicking 
the button to the right opens a dialog box that allows 
you to navigate through the directory tree on your hard 
disk or a floppy disk, and select the desired destination 
directory. 
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 File Name : This text box is used to specify the name of the file to 
which you wish to record the data from the receiver. 

   - If you choose the Automatic File Name option (i. e. 
if the option box is checked), then the File Name text 
box is dimmed and the name is automatically assigned 
by the system, based on the date (month, day 
number) and time (hour, minute) of the recording 
session. 

   Example: 12240929 for a file recorded on December 
24 at 9:29 a. m. 

   - If you do not select the Automatic File Name option, 
then you can enter a name of your own. Unless a 
maximum size is selected for the file, you are also 
allowed to enter an extension into the associated box. 

 File Max Size : This option box is used to specify whether a single file 
should be created on the disk (No Limits option) or the 
file should be split into 0.7 MB or 1.4 MB segments 
(with a view to storing it to floppy disks). 

   If you elect to split the file into segments, then the 
system will automatically add 001 as extension to the 
name of the first segment. This will automatically be 
incremented for each file segment generated, if the file 
exceeds the File Max Size selected. 

 Start Date : This text box is used to specify the day on which the 
recording session should begin. The current date is 
prompted by default. 

 Start Time : This text box is used to specify the time when the 
recording session should begin. The current time is 
prompted by default. 

 Duration : This text box is used to specify the planned duration of 
the recording session. 
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 Automatic 
 File Name : If you choose this option (i. e. if the option box is 

checked), then the File Name text box is dimmed and 
the name is automatically assigned by the system, 
based on the date (month, day number) and time 
(hour, minute) of the recording session. Example: 
12240929 for a file recorded on December 24 at 9:29 
a. m. 

   If you do not select the Automatic File Name option, 
then you can enter a name of your own. Unless a 
maximum size is selected for the file, you are also 
allowed to enter an extension. 

 Add Request : This button saves the recording session description 
currently displayed and increments the number of pro-
grammed sessions that appears at the bottom of the 
scrollbar. (This automatically selects the Automatic 
File Name option and prompts the next possible ses-
sion, considering the specified Duration). 

 Delete Request : This button deletes the recording session description 
currently displayed and decrements the number of 
programmed sessions that appears at the bottom of 
the scrollbar. 

 Run Program : This button activates the Programmable GPS 
Recorder mode. This causes Win Comm to wait for 
the next scheduled recording session and perform 
recording as planned. The label of the button changes 
from Run Program to Stop Program. Until the 
planned recording is complete or you click Stop 
Program, all other buttons in the Programmable GPS 
Recorder pane are inhibited and you cannot change to 
another mode. 
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 Load Program : This button opens a dialog box that allows you to se-
lect a file (typically a .pgm file) containing descriptions 
of planned recording sessions (saved earlier using the 
Save Program button). Select the desired file name 
and click Open. 

 Save Program : This button opens a dialog box that allows you to save 
descriptions of planned recording sessions so that 
they can be used at a later date (using the Load 
Program button). Enter a name into the File Name text 
box and click Save. 

 Print Program : This button opens a Print dialog box that allows you to 
print the descriptions of planned recording sessions 
currently loaded. 



Using Conf Pack connected to a THALES GNSS receiver 
Display Pane / Window 

4-16  

4 

Display Pane / Window 

After communication is enabled between the computer and a GPS receiver 
the Display pane allows you to view the data stream on the receiver port, 
including data output in response to any command generated by Win 
Comm. 

 

 
 

If you wish to enlarge the Display pane, click  in this pane (top right). 
This causes the pane to be transformed into a separate window which you 
can move/re-size using the usual commands assigned to windows in the 
Windows95 environment. To restore the Display pane at the initial location, 
click  or  (top right). 
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As the data may be refreshed every 0.1 seconds, it is not possible to log all 
that is relayed through the port so that it can be displayed at a later date, or 
this would require a huge memory size. For that reason, only the latest 100 
data lines are stored and can be viewed using the vertical scroll bar avail-
able. 

Each data line ends with a CR LF code and/or when it reaches the 
maximum length (90 characters). 

The Display pane contains the following buttons: 

 

 Pause : Freezes the Display pane and changes the 
label of the button to Resume. 

   Pressing the Pause button does not suspend 
the data flow on the receiver port or the 
recording in progress. 

   Pressing this button again (now changed to a 
Resume button) will re-activate the Display 
pane. 

 Clear View... : Deletes any data displayed in the Display pane 
/ window. 

 Print View... : Opens a Print dialog box that allows you to 
print any data displayed in the Display pane / 
window. 
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Loading a new geoid 

The Geoids module, a separate module that can be directly launched from 
Conf Pack, allows you to: 

- import geoids 

- extract data from a geoid to create a smaller file containing just 
the necessary data for your working area 

- load partial or complete geoid models directly into a GNSS 
receiver. 

Three geoid models are available in the Geoids module: RAF98 (France), 
EGM96 (Global) and GDS95 (Canada) 

 

Starting the Geoids module: 

- On the Conf Pack Tools menu, select Geoids. This starts the Geoids 
module. 

 

Importing a new geoid model: 

- In the Geoids window, select File>Import and indicate the location of 
the corresponding file. 

 

Opening a geoid model: 

- In the Geoids window, select File>Open. This function indicates the 
following: geoid name, limits of geographical area, grid step, file size, 
number of points. 
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Extracting data from a geoid model: 

- A geoid model must be open in the window 

- In the Geoids window, select File>Extract As…. Define the 
characteristics of the data extraction (name, format). To indicate the 
limits of your working area, you can advantageously use the World 
Map function, by clicking the World Map button, rather than type the 
coordinates of the N-W and S-E limits of the area. 

- Click the Extract button to create the new file. This file is automatically 
opened in the Geoids window after being created by the module. 

 

Loading a geoid model into a receiver: 

- A geoid model must be open in the window (a complete or partial 
geoid). Establish a serial link between one of the ports on your PC 
and, for example, port A on the Scorpio (any RS232 port can be used 
on the Scorpio), using the appropriate cable. 

- In the Geoids window, select Transfer>Write. A dialog box appears 
asking you to choose and set the serial port on your PC now 
connected to the Scorpio. 

 After setting the port, click OK to start and complete the file transfer. 

 ♣ 
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5. Complete description of the nine mod-
ules of Configuration Parameters 

Modules and sub-modules 

As shown in the Select Pane, the modules and sub-modules of 
configuration parameters are the following: 

 

DESCRIPTION  
 Comment  SCREEN 
GEODETIC SYSTEMS  Appearance 
 Coordinate Systems   Preferences 
 Current  NAVIGATION 
 Altitude  Waypoints 
PROCESS  Routes 
 Satellites   Mode 
 Reference Position  SESSIONS 
 Time  Description 
 Filter   Sequencing 
 Main Mode  DGNSS 
  Maximum DOP  Beacons 
  Quality Control  Mode 
INPUT \ OUTPUT  PRCs Time Out 
  Communications  DGNSS data  
  Formats WAAS \ EGNOS 
  Computed data  Mode 
  Pseudo Ranges  Data 
 GPS data 
 Bit flow 
 Event Time Mark 
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DESCRIPTION 

 Comment : Free text limited to 30 characters per line; 6 
lines max; a key note for clear identification of 
the configuration. 

 

 

Example of comment as reported in the Graphic Pane: 
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GEODETIC SYSTEMS 

��Coordinate Systems 
You can create up to 10 rows in the Editor table. Each row should contain 
the complete description of a coordinate system, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this coordinate system is 
defined 

 Coord. System : Name of the coordinate system 

 Datum : Name of the datum used 

 a : Semi-major axis of the datum used (in meters) 

 1/f : Inverse of the flattening coefficient 

 k : Scale Factor 

 Dx, Dy, Dz : X, Y, Z deviations of the datum compared with 
the reference ellipsoid (signed values in 
meters) 

 Rx, Ry, Rz : Angular deviations of the datum around the X, 
Y Z axes compared with the reference ellipsoid 
(angles in seconds) 

 Proj. Kind : Kind of projection used (Geocentric, Lat/Long, 
1P-Lambert, 2P-Lambert, Stereographic, Rect-
SkewOrtho or SkewOrtho, utm) 
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 False Easting : Easting for projection center 

 False Northing : Northing for projection center 

 Central Meridian : Longitude of projection center 

 Central or North Lat. : Latitude of projection center or latitude of 1st 
parallel respectively 

 Scale or Ref Lat. : Scale factor or latitude of projection center re-
spectively 

 Skew or South Lat. : Azimuth of initial line or latitude of 2nd parallel 
respectively 

 

Example of coordinate system, as reported in the Graphic Pane: 
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��Current 
 Current Coord. System : Name of the coordinate system which 

your receiver(s) will use by default. 

   Following the choice you make in this 
cell, the Graphic pane shows a 
sample of coordinate transformation 
resulting from your choice. The 
sample uses as input the coordinates 
entered in the Variables window 
(accessed by selecting 
Tools>Options>Variables tab) 

 

��Altitude 
 Mode : Choose the default altitude computation mode for 

your receiver(s): 

 WGS84 −−−− MSL : Altitude computed on Stanag geoid 
grid 

 WGS84 : Altitude computed on the WGS84 
ellipsoid 

 Ellipsoid : Altitude computed on user ellipsoid 

 User geoid : Altitude computed on user geoid 

 Offset : Specify the antenna height with respect to the cho-
sen reference (in meters) 

 

Example of Altitude as reported in the Graphic Pane: 
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PROCESS 

��Satellites 
 Minimum elevation : By default, only the satellites above this eleva-

tion angle, seen from the current location(s) of 
your receiver(s), will be used in the position 
processing 

 Deselected SVs : PRN numbers of the satellites you do not want 
your receiver(s) to use (whatever their eleva-
tion angles) (Default deselection). 

   (from 1 to 33 for GPS satellites, from 120 to 
138 for WAAS/EGNOS satellites) 

 

��Reference Position 
Precise coordinates of the DGPS reference station, or of the mobile receiver 
if KART or LRK initialization must be performed from this location. 

(A single row possible in the Editor table). 

 Coord. System : Specify the coordinate system in which the 
reference position is expressed (choose one of 
the coordinate systems you have defined, or 
the default one) 

 Input : Type of coordinates used to express the 
reference position 

 Latitude/Northing : Latitude, or Easting of the reference position, 
depending on the coordinate system used 

 Longitude/Easting : Longitude, or Northing of the reference 
position, depending on the coordinate system 
used 
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 Altitude/Height : Altitude of the reference position, depending on 
the coordinate system used 

 

��Time 
(A single row possible in the Editor table) 

 Date : Local date 

 Time : Local time 

 Time Zone : Time zone of the operating area 

 

Example of time setting as reported in the Graphic Pane: 

 

 
 

��Filter 
 Speed Filter Time Constant : Default Speed Filter time con-

stant (0.0 to 1000.0 seconds) 
(default: 6.0 seconds) 
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��Main Mode 
 Process : Position process type (this choice depends on the 

destination of your receiver) 

 Reference Station : Configuration file intended for a stationary 
receiver, associated with a reference 
station transmitting corrections 

 Monitoring Station : Configuration file intended for a stationary 
receiver, associated with a monitoring 
station 

 GPS Natural : Configuration file intended for a "pure" 
GPS receiver (i.e. not including a DGPS 
correction receiver) 

 DGPS : Configuration file intended for a GPS 
receiver capable of receiving and 
processing DGPS corrections 

 Reserved : (For future use) 
 EDGPS : Configuration file intended for a GPS 

receiver capable of receiving KART/LRK 
data and processing EDGPS solutions 

 KART/LRK : Configuration file intended for a GPS 
receiver capable of delivering a KART or 
LRK position solution with OTF initialization 

 L1...L2 : Indicates which GPS frequencies will be processed 
(L1 or L1+L2) in the receiver. The only possible choice 
is L1/L2 for the first 4 options of Process (Reference 
station, Monitoring station, GPS Natural, DGPS). If 
Process=EDGPS or KART/LRK, the possible options 
are: 

 L1/L2 : Dual-frequency processing 
 L1/L2 WL : Wide-Lane dual-frequency processing 
 L1 only :  Single-frequency processing 
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   The type of processing performed in the receiver will 
depend on the GPS & DGPS data received and the 
type of firmware options installed in the receiver. 

 
 System : Allows you to select the source of positioning data 

(GPS + corrections data) needed for the process you 
have chosen in the Process cell (previous cell). The 
possible options for this cell are also deduced from the 
selection you have made in the previous cell. 

DGNSS Sta. or Geo. SV 
Fix Type or Data Ref. : Identification number(s) of the reference station(s) 

used (up to 4 stations) or GEO PRN, according to the 
selections in the Process and System cells (see table 
below). 

   The possible combinations of parameters are listed 
below: 

 
Process 

 
System 

Corresponding 
source of 

corrections or 
data 

L1...L2 
DGNSS Sta. or 

Geo. SV Fix 
Type or Data 

Ref. 
Reference 
station GPS Nat GPS L1/L2 - 

GPS Nat GPS L1/L2 - 
 

DGPS/KART/LRK 
GPS + Reference 
station or NMEA 
message 

L1/L2 DGNSS station 
number 

Monitoring 
station 

WADGPS GPS + GEO SV L1/L2 - 
GPS Nat GPS Nat GPS L1/L2 - 

GPS + Reference 
station or NMEA 
message 

L1/L2 DGNSS station 
numbers DGPS 

DGPS/KART/LRK  
 
 
WADGPS GPS + GEO SV L1/L2 Geo SV Numbers 

EDGPS or 
KART/LRK DGPS/KART/LRK 

GPS + Reference 
station or NMEA 
message 

L1/L2, L1/L2 WL 
or L1 only 

DGNSS station 
numbers 
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��Maximum DOP 
 Maximum Dop : Maximum Dilution of Position permitted (1 to 

99) (future use) 

 

��Quality Control 
 Autonomous QC : From the associated combo box, choose the 

desired option: 

    None 
    or UKOOA 
 External QC : From the associated combo box, choose the 

external source of data ensuring Quality Con-
trol: 

    None 
    or WAAS\EGNOS 
    or RTCM_SC104 

 DGNSS Station 
 or GEO. SV : Identification number of the reference station 

used or GEO PRN, according to the selection 
in the preceding cell. 
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INPUT / OUTPUT 

��Communications 
You can create as many rows as necessary in the Editor table. Each row 
should contain the complete description of a receiver port, as defined below: 

 Port : Port name (A, B, C or D) 

 Baud Rate : Port speed (300 to 115200 Bd) 

 Data Bits : Number of data bits (7 or 8) 

 Stop Bits : Number of stop bits (1 or 2) 

 Parity : None, odd or even 
 

��Formats 
You can create up to 40 rows in the Editor table. Each row should contain 
the complete description of a format, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this format is defined 

 Format : Expression of the format. 

     (See Programming instructions for the de-
sign of screens & data outputs to learn how 
to write a format with the proper syntax. 
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��Computed Data 
You can create up to 20 rows in the Editor table. Each row should contain 
the complete description of a computed-data message, as defined below: 

 # : Software-set field, identifies the row in the Editor table 
where this computed-data message is defined 

 Port : Receiver port on which this computed-data message will 
be available (A, B, C, D, P) 

 Output Mode : Event triggering the message:  

 STOP : Message inhibited (no trigger event, forces 
On/Off to OFF) 

 TIME : Message delivered at regular intervals of time 
(defined by Rate below) 

 EVENT : Message triggered by an external event 

 IMMEDIATE : Message triggered on releasing the message 
output (when changing the On/Off status to 
ON) 

 1PPS : Message triggered by the 1PPS output signal 

 MANUAL : Message triggered by operator 

 TR : Message triggered by the TR command sent by 
an external equipment through a serial port 

 On/Off : Default message status when turning on the receiver 
(ON or OFF) 
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 Rate 
 (in 1/10 s or ticks) : Factor (0 to 99 999) defining the output rate for this 

message: 

   In TIME output mode, the value of output rate is 
expressed in 100-ms units 

   In all other output modes, the value of output rate will 
result from both the occurrence of the chosen trigger 
event, which is variable (except for the 1-Hz fixed 
frequency 1PPS), and the value of Rate, which specifies 
the required count of occurrences of the chosen trigger 
event before a new message is delivered. 

   For example, in EVENT mode, with Rate=2, a message 
will be issued every two occurrences of the external 
event signal. In 1PPS mode,  with Rate=10, a message 
will be issued every ten seconds 

   In MANUAL output mode, Rate will generally be set at 
1. 

  

 Format 1... 
 Format 10 : Numbers of 1st, 2nd, ..., 10th format in the script gener-

ating this message 
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��Pseudoranges 
You can create up to 2 rows in the Editor table. Each row should contain the 
complete description of a pseudorange message, as defined below: 

 # : Software-set field, identifies the row in the Editor table 
where this pseudorange message is defined 

 Port : Port on which this Pseudoranges message will be 
available (A, B, C, D, P) 

 Output Mode : Event triggering this message: 

 STOP : Message inhibited (no trigger event) 

 TIME : Message triggered at regular intervals of time 
defined in the Rate column 

 EVENT : Message triggered at every occurrence of the 
signal chosen from the Rate column 

 On/Off : Default message status when turning on the receiver 
(ON or OFF) 

 Rate : In TIME output mode, Rate is a factor defining the 
output rate of the message (expressed in 100-ms units) 

     In EVENT output mode, Rate is a drop-down menu from 
which you should choose the trigger event (EVT1 or 
1PPS). In this mode, the value of output rate will simply 
result from the occurrence of the chosen trigger event (1 
second with 1PPS). 
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 Format : SBIN@r, SBIN@R, SBIN@Q, SVAR!R or SVAR!Q 

 Antenna : Main or All 

 GPS C/P Filter : GPS Code/Phase filter (0 to 600 s) 

Minimum elevation : Minimum elevation angle setting for the satellite from 
which the pseudorange originates. 

 

 

��GPS Data 
You can create up to 2 rows in the Editor table. Each row should contain the 
complete description of a GPS-data message, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this GPS-data message is 
defined 

 Port : Port on which this GPS-data message will be 
available (A, B, C, D, P) 

 On/Off : Default message status when turning on the 
receiver (ON or OFF) 

 Format : S_VAR! or S_BIN@ 

 Ephemeris : Yes if ephemeris data included in the message, 
otherwise No 

 Almanacs : Yes if almanac data included in the message, 
otherwise No 

 Iono-UTC : Yes if Iono-UTC data included in the message, 
otherwise No 

 Health & A/S : Yes if Health & A/S data included in the mes-
sage, otherwise No 
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��Bit flow 
You can create up to 2 rows in the Editor table. Each row should contain the 
complete description of a bit-flow message, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this bit-flow message is 
defined 

 Port : Port on which this bit-flow message will be 
available (A, B, D, P) 

 On/Off : Message type: OFF (none), SBIN@b or 
SVAR!B 

 Rate : Factor (1 to 15) defining the output rate of the 
message (0.6 to 9 seconds) 

   (expressed in 0.6-second units) 
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��Event Time Mark 
You can create up to 2 rows in the Editor table. Each row should contain the 
complete description of a Time-Mark message, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this message is defined 

 Port : Port on which this message will be available (A, 
B, C, D, P) 

 Output mode :  

 STOP : Message inhibited (no trigger event) 

 EVT1 : Message triggered at every 
occurrence of the signal chosen from 
the Rate column 

 1PPS : Message triggered at regular intervals 
of time defined in the Rate column 

 On/Off : Default message status when turning on the 
receiver (ON or OFF) 

 Rate : Factor defining the output rate of the message 
(1/factor of event or 1PPS))  

 Format : Message type: S_VAR!M or S_BIN@M 
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SCREEN 

��Appearance 
You can create up to 10 rows in the Editor table. Each row should contain 
the complete description of a screen, as defined below: 

 
 # : Software-set field, identifies the row in the 

Editor table where this screen is defined. 

 Format 1...   Format 10 : Numbers of 1st, 2nd, 3rd,... 10th format in the 
script generating this screen 

 

��Preferences 
(A single row possible in the Editor table) 

 Language : Language used in the operator interface of 
receivers (French or English) 

 Lat Long Format : Specify the angle unit which Conf Pack should 
use: Degrees Minutes Seconds or Degrees 
Minutes 

 Distance Unit : Specify the distance unit which Conf Pack 
should use: Meters or Nautical Mile 

 North  : Specify the definition of the North which Conf 
Pack should use: Geographic, Grid or Magnetic 
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NAVIGATION 

��Waypoints 
You can create as many rows as necessary in the Editor table. Each row 
should contain the complete description of a waypoint, as defined below: 

 
 # : Software-set field, identifies the row in the 

Editor table where this waypoint is defined 

 Name : Name of the waypoint 

 Coord. System : Coordinate system in which the coordinates of 
this waypoint are expressed. Choose one of 
the coordinate systems you have defined, or 
the default one. 

 Input : Type of coordinates used to express the 
reference position 

 Latitude/Northing : Latitude or Northing of the waypoint, depending 
on the type of coordinate system used 

 Longitude/Easting : Longitude or Easting of the waypoint, 
depending on the type of coordinate system 
used 

 Altitude/Height : Altitude of the waypoint, depending on the 
altitude computation mode used 
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Example of waypoints as reported in the Graphic Pane: 

 

  
 

• Alternate procedure: 
 

 Waypoints can be defined directly from the Graphic Pane (see 
page 3-5) 
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��Routes 
You can create as many rows as necessary in the Editor table. Each row 
should contain the complete description of a route, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this route is defined 

 Name : Route name 

 Waypoint 01 
 to Waypoint 12 : Numbers of the waypoints forming the route 

(up to 12 waypoints) 

 

Example of routes as reported in the Graphic Pane: 

 

  
 

• Alternate procedure: 
 

 Routes can be defined directly from the Graphic Pane (see page 
3-5). 
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��Mode 
(A single row possible in the Editor table) 

 Working Mode : Specify the nature of the position solution used in the 
navigation function. The available options are tied to 
the option you chose in the Process module, Mode 
sub-module (see page 5-8): 

   "(D)GPS" is the only possible option if you chose GPS 
Natural, DGPS or MDGPS 

   "(D)GPS" and "EDGPS" are the 2 options possible if 
you chose EDGPS 

   "(D)GPS", "EDGPS", "KART_A" and "KART_R" are 
the 4 options possible if you chose KART/LRK 

   This field, and also the whole Mode sub-module, is 
irrelevant to a station (reference or monitoring) 

 Mode : Choose the default Navigation mode (Position, 
Homing, Bearing or Profile) which should be used in 
your receiver(s) 

 POSITION : Provides basic positioning information (position, 
speed, course, etc.). This mode can be used when 
no further navigation information is required. 
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 HOMING : Navigation mode based on a waypoint that you spec-
ify. This mode will provide information to help the 
operator reach that point along a great circle (basic 
positioning information also available). 

 

 

 

 

 

 

 
 BEARING : Navigation mode also based on a waypoint that you 

specify. This mode will provide information to help the 
operator reach that point according to the bearing 
angle defined by the waypoint location and the cur-
rent location when he/she selects this mode (basic 
positioning information also available). 

 

CTW

Receiver 
location 

Waypoint 

DTW

NVariables specific to the Homing 
Mode: 
 CTW : Course To Waypoint 
 DTW : Distance To Waypoint 
 TTG : Time To Go 

XTE

ATD

CTS

Receiver location 
when selecting 

the Bearing mode 

Current Receiver 
location 

Waypoint 

DTW 

NN

CTW

Variables specific to the Bearing Mode: 
 CTS : Course To Steer 
 XTE : Cross Track Error 
 ATD : Along Track Distance 
 CTW : Course To Waypoint 
 DTW : Distance To Waypoint 
 TTG : Time To Go 
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 PROFILE : Navigation mode based on a route that you specify. 
This mode will provide the information required to 
help the operator navigate along this route (basic po-
sitioning information also available). 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 Waypoint or Route : If the Homing or Bearing mode is selected, specify 
the number of the target waypoint 

   If the Profile mode is selected, specify the route 
along which to navigate 

 Direction : If the Profile mode is selected, specify whether the 
route must be traveled Forward (from first to last 
waypoint) or Backward 

 Bearing : If the Bearing mode is selected, specify the Course 
To Steer 

 Start on WPT : If the Profile mode is selected, specify the name of 
the waypoint to reach first (necessarily a waypoint 
part of the selected route). 

XTE

ATD

Variables specific to the Profile Mode: 
 CTS : Course To Steer CTW : Course To Waypoint 
 NCTS : Next Course To Steer DTW : Distance To Waypoint 
 XTE : Cross Track Error ATD : Along Track Distance 
 TTG : Time To Go 

Route: 
 1st segment : WPTaa-WPTbb 
 2nd segment : WPTbb-WPTcc 
 3rd segment : WPTcc-WPTdd 

Receiver location

WPTaa WPTdd 

WPTcc

WPTbb

NCTS

DTW

N

N

N
CTS

CTW
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SESSIONS 

��Description 
You can create up to 8 rows in the Editor table. Each row should contain the 
complete description of a session, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this session is defined 

 Session Label : Label assigned to the session (8 characters 
max.) 

 Start Time : Session start time (format: hh mm ss.s) 

 Stop Time : Session stop time (format: hh mm ss.s). The 
maximum duration of a session is 24 hours (i.e. 
when Start Time= Stop Time) 

 Record : Recording indicator: 

   Yes: session with recording 

   No: session without recording 
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��Sequencing 
(A single row possible in the Editor table) 

 Working Mode : Specify the type of sequencing for the programmed 
sessions: 

 END : All sessions are disabled 

 IMMED : Will cause the receiver to start operating and 
recording data on PCMCIA (if this option is 
installed) as soon as it is turned on) 

 ON : Programmed sessions are run once 

 CYCLE : Programmed sessions will be repeated, if this 
may happen (i.e. the receiver is maintained in 
that working mode for a sufficient time) 

 

 Power Mode : Specify the control mode of the power supply: 

 AUTPW : Automatic control. The receiver will operate 
according to the sessions programmed. If no 
session is programmed, the receiver will auto-
matically turn off at the end of 30 seconds of 
operation 

 MANPW : Manual control. The operator has full control of 
the receiver: she/he will be able to freely turn it 
off and on outside work sessions. 
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 Session 1... 
 Session 8 : Give the order in which sessions should be run (8 

cells: up to 8 sessions possible). 

     In each cell, choose a session number from the drop-
down menu listing all the existing sessions, as defined 
in SESSIONS, Description. 

     A session number can be specified in several cells (in 
which case running all the sessions will necessarily 
two (or more) days. 
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DGNSS 

��Beacons 
You can create up to 20 rows in the Editor table. Each row should contain 
the complete description of a beacon, as defined below: 

 Beacon ID : Identification number of the beacon 

 Name : Beacon name 

 Lat: : Beacon latitude 

 Long: : Beacon longitude 

 Band. 1 : Transmission band used 

 Freq. 1 (Hz) : Carrier frequency 

 Band. 2 : For future use 

 Freq. 2 (Hz) : For future use 

 Range (km) : Estimated beacon range 

 Baud Rate : Data Transmission baud rate 

 Modulation : DQPSK (D) or GMSK (G) 

 Encryption : Yes (corrections encrypted) or No (corrections 
in plain) 

 C3 code : C3 encryption code, provided by the beacon's 
owner. You may not type C3 at this stage, but 
when later the receiver user wishes to work 
with that beacon, the receiver will request that 
code (6 figures). 
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Example of beacon as reported in the Graphic Pane 

 

  
 

 

• Other procedure: 
 

 Beacons can be defined directly from the Graphic Pane (see 
page 3-14). 
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��Mode 
You can create up to 3 rows in the Editor table. 

In each row, you define the receiver either as a corrections generator (a 
reference station) or a corrections receiver (a user receiver). You can define 
only a single reference station and two corrections receivers max. 

 # : Software-set field, identifies the row in the 
Editor table where this reference station is 
defined 

 Port : A, B, C or D 

 Mode : Reference station (XMTR) or corrections 
receiver (RCVR) 

 Beacon ID : Identification of the beacon connected to the 
reference station (if a reference station) or from 
which corrections are received (if a user re-
ceiver) 

 Period (XMTR) : Data transmission rate (if a reference station) 

 Slot (XMTR) : Number of the slot during which corrections are 
received from the specified beacon (if a user 
receiver) 

 Station ID (RCVR) : Number of the reference station connected to 
the specified beacon 

 Station ID (RCVR) : Number of the reference station connected to 
the specified beacon (if there is a second one) 
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 Station ID (RCVR) : Number of the reference station connected to 
the specified beacon (if there is a third one) 

 Station ID (RCVR) : Number of the reference station connected to 
the specified beacon (if there is a fourth one). 

 

 You can only enter 4 different station ID's over the possible three 
rows of the Editor table. 

 

 

��PRCs Time Out 
 PRC Time Out : Maximum age of corrections (1.0 to 100.0 sec-

onds) 

 

��DGNSS data 
You can create up to 2 rows in the Editor table. Each row should contain the 
complete description of a DGNSS-data message, as defined below: 

 # : Software-set field, identifies the row in the Editor table 
where this DGNSS-data message is defined 

 Port : Port on which this DGNSS-data message will be 
available (A, B, C, D, P) 
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 Output Mode : Event triggering this message: 

 STOP : Message inhibited (no trigger event) 

 TIME : Message triggered at regular intervals of time 
defined in the Rate column 

 EVENT : Message triggered at every occurrence of the 
signal chosen from the Rate column 

 IMMEDIATE : Message triggered on releasing the message 
output (when changing the On/Off status to 
ON). 

 
 On/Off : Default message status when turning on the receiver 

(ON or OFF) 

 Rate : In TIME output mode, Rate is a factor defining the 
output rate of the message (expressed in 100-ms units). 

     In EVENT output mode, Rate is a drop-down menu from 
which you should choose the trigger event (EVT1 or 
1PPS). In this mode, the value of output rate will simply 
result from the occurrence of the chosen trigger event (1 
second with 1PPS). 

     In IMMEDIATE output mode, Rate is irrelevant 
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 Format : Type of DGPS data contained in the message: 

 RTCM_SC104 : RTCM SC104-formatted data 

 LRK_UHF : DSNP-formatted data transmitted in the UHF 
band to operate in LRK 

 DSNP_UHF : DSNP-formatted data, transmitted in the UHF 
band, allowing operation in KART mode 

 SVAR!D : Non-configurable GPS data in ASCII format 
with field delimiters 

 USERS_DATA : Data transmitted in a user format 

 

 Station Type : Type of the station generating the DGPS corrections 
contained in the message: 

 ALL : Any type 

 UHF : Station transmitting in the UHF band 

 HF : Station transmitting in the HF band 

 MF : Station transmitting in the MF band 

 RTCM numeric : Station transmitting data in the RTCM format 

 

 Message 
 Number : Number of the corrections sentence, from the selected 

type of station, chosen to be part of the message (ex-
cluding the others) (for RTCM-SC104 and KART 
formats only). 
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WAAS \ EGNOS 

��Mode 
(A single row possible in the Editor table) 

 Selection mode : Choose the type of integrity control you want to 
implement using the WAAS \ EGNOS: 

   OFF: none 

   Auto: the receiver will automatically find 
the GEO with which to work  

   Manual: the receiver will only work with the 
specified GEO (s) (see below) 

 First selected SV : If Manual selected (see first cell), enter the 
PRN of the GEO to be used first for the 
integrity control and WADGPS 

 Second selected SV : If Manual selected (see first cell), enter the 
PRN of the GEO to be used for the integrity 
control and WADGPS if the 1st one is not (or is 
no longer) available. 
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�� Data 
You can create up to 2 rows in the Editor table. Each row should contain the 
complete description of a data message, as defined below: 

 # : Software-set field, identifies the row in the 
Editor table where this GPS-data message is 
defined 

 Port : Port on which this data message will be 
available (A, B, C, D, P) 

 On/Off : Default message status when turning on the 
receiver (ON or OFF) 

 Format : S_VAR!W or S_BIN@W 

♣ 
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6. Programming Instructions for the de-
sign of screens and data outputs 

Terminology 

 Element : Basically, a piece of information whose result should be 
seen on the receiver screen or inserted into an output 
message. This can be text, the name of a variable or the 
expression of a mathematical operation on one or more 
variables, etc. 

 Format : A character string consisting of an element and notation 
instructions applying to this element. 

 Macro : A ready-to-use script, simply invoked by a three-letter 
name, and from which the receiver can generate a stan-
dard NMEA0183 output message. 

 Notation : Refers to how an element should be presented in a screen 
or output message: maximum length permitted, number of 
decimal places, etc. 

 Result : A character string (numeric or alphanumeric) generated 
by the receiver, computed from what is contained in a 
format (i.e. element+notation).This can be text, the 
current value of a variable or the result of a mathematical 
operation on one or more variables, etc. 

 Script : A series of formats from which a receiver can generate a 
complete screen or output message. 

 Variable : Any numeric or alphanumeric data handled by a receiver. 
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Creating formats 

��General expression 
The general expression of a format is:  E:n:d 

where: 

- E identifies the element contained in the format. E may be of 
different forms: 

. A character string (text) 
 between single quotation marks: e.g.: 'Latitude' 

. A single variable: e.g.: L84 

 or a macro: e.g.: GGA 

. A combination of variables, 
 operators and numerals: e.g.: SEXAM(LAT) 

  e.g.: INT(DRMS)/2 

 

- In general, n and d are two numerals defining the notation of the 
format. When E stands for a macro, n and d have a different 
meaning (see page 6-14) 

 The “:” symbol is used as a separator between E, n and d. 
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��Possible notations 
Fixed notation: n > d 

In this notation: 

- n is the total number of characters, including the decimal point, 
used to display the result (n ≤ 20) 

- d is the number of characters reserved for the fractional part of 
the result (n includes d) 

 
Free notation: n  ≤≤≤≤ d 

In this notation: 

- n is irrelevant 

- d is the number of characters reserved for the fractional part of 
the result 

- The result is presented with the number of characters needed, 
provided it is less than 20. 

 
Particular cases: 

 n and d not specified 

- Default values are then used for n and d. With most 
operators, n = d = 0, which means that the free 
notation is used, with no fractional part since d = 0. 

- For some operators (HMS, LATM, LONM, SEXAM, 
SEXAS), the default value for d is "0", unlike n as the 
size of the result is generally known and n is adapted 
to the size. 

 n specified, d not specified 

- The default value d = 0 is chosen. The fixed notation 
is therefore used with no fractional part since d = 0. 
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��Numerals 
General form: 

 
Examples: 

 
All operations with numerals are processed with double precision. 

 

��Leading spaces 
All values are pushed to the right with leading spaces ahead of the value if 
the data field is larger than required. There are three exceptions, however: 

- TXT pushes characters to the left (trailing spaces) 

- ZERO pushes to the right, and adds leading zeros 

- HEXA pushes to the right and adds leading spaces. 
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��Control characters 
 Comma : delimiter between any two adjacent parameters 
     e.g.: CHR(3),CHR(10) 

 Quotation marks : used to replicate the character string specified in 
between. 

     e.g.: 'Longitude'  or  'User"s' 

   When present in text, the apostrophe character 
must be doubled to appear in the result, as shown 
in the second example above (resulting text: 
User's) 

 Colon : used in the data formatting syntax  
     e.g.: COS(BR):5:3 

 Parentheses : used to bound an operation within an expression. 6 
parenthesis levels are possible. 

    e.g.: HEXA(INT(GDOP*100)+300):4 

 Square brackets : used in indexed variables (indexes from 1 to n 
according to variable type) 

     e.g.: CSV[[[[5]]]] 

 Braces : used by IF operator 
 Dot : Decimal point 
 
 

��Overflow condition 
Any overflow will result in the following type of value: *999 . . .9. Depending 
on the chosen notation (fixed or free), the number of 9's may vary and the 
decimal point may be present or not. 
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Operators 

��Operators list 
 + Addition 
 - Subtraction 
 * Multiplication 
 / Division 
 = Assigns a variable to UV[n] 
 ABS(x):n:d Absolute value of the x variable 
 ARCTAN(x):n:d Arctangent of the x variable 
 CAN:x Provides satellite status data for the specified 

channel number (x) and for the next three 
ones 

 CHR(x) Returns the ASCII character whose code is x 
 CHK:e:f Computes the complement parity from the eth 

character up to the fth character 
 COS(x):n:d Cosine of the x variable 
 CRC:e:f Computes parity from the eth character up to 

the fth character 
 DAT(x):m:c Returns the date with m characters in a 

format depending on c 
 DEG(x):n:d Converts the x variable from radians to 

degrees 
 FRACT(x):n:d Fractional part of the x variable 
 HEXA(x):m Returns the x variable in hexadecimal 

notation with m characters 
 HMS(x):n:d Converts the x variable from seconds to 

hours, minutes, seconds 
 INT(x):n:d Returns the integer part of the x variable 
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 KMH(x):n:d Converts the x variable from m/s to km/hr 
 IF(x$y){f1}{f2} Returns f1 or f2 depending on whether the 

x$y relation is true or not 
 KN(x):n:d Converts the x variable from m/s to knots 
 LATM(x):n:d Converts latitude x from radians to degrees, 

minutes, direction 
 LN(x):n:d Natural logarithm of the x variable 
 L0G(x):n:d Common logarithm of the x variable 
 LONM(x):n:d Converts longitude x from radians to degrees, 

minutes, direction 
 NM(x):n:d Converts the x variable from meters to 

nautical miles 
 SEXAM(x):n:d Converts the x variable to sexagesimal value 

(degrees or hours, minutes) 
 SEXAS(x):n:d Converts the x variable to sexagesimal value 

(degrees or hours, minutes, seconds) 
 SIGN(x):p:q Returns p or q (ASCII characters), depending 

on the sign of the x variable  
 SIN(x):n:d Sine of the x variable 
 SQRT(x):n:d Square root of the x variable 
 TXT:x:n Returns the text associated with the x 

variable, with n characters 
 ZERO(x:n:d) Puts leading zeros ahead of x (x: variable or 

expression) 
 

For all operators using n and d, the format notation complies with the infor-
mation provided in the fixed/free notation paragraph. 
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��More about some the available operators 
 CAN: 

 Delivers four lines of status data: 

. the first line contains satellite status data corresponding to 
the specified reception channel (x), 

. the 2nd, 3rd and 4th lines contain the status data 
corresponding respectively to reception channels x+1, x+2 
and x+3 (if any) 

 Each line generated by this operator is formatted as follows: 

CAN,<x>,<SV>,<elevation>,<azimuth>,<SVorbit>,<status>,<S/N>,<CR><LF> 
 where: 

 x : channel number, as specified by operator 

 SV : PRN number of the SV being processed on that channel 

 Elevation : Satellite elevation (0.. 90°) 

 Azimuth : Satellite azimuth (0.. 360°) 

 SV orbit : Satellite orbit : Ascending (1) or descending (0) 
  (Ascending=negative Doppler; descending=positive Doppler) 

 Status : Channel status: 
 0: No satellite received (unused channel) 
 1: Satellite received (SV received & used) 
 2: Satellite received so far on that channel has been lost 
 3: Satellite usable (SV received, ephemeris available) 
 4: Same as 3 + SV involved in PVT processing (PVT=Position 

Velocity Time 
 5: Specified SV being tracked 
 6: SV received on that channel intentionally rejected 
 7: SV rejected by WAAS integrity test 
 S/N : Signal/Noise ratio, in dB 
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 Any unavailable data will be denoted by the 3 symbols "***" in the 
corresponding field. 

 As the data block generated by the CAN operator is about 100 
characters in size, and the maximum length of a computed-data 
message is 255 characters, you should do the following to output 
the status data of 16 channels: 

- From the Formats sub-module of Conf Pack, 
define two formats as follows: 

 Format #1: 

 CAN:1,CAN:5 

 (will generate status data for channels. 1 to 8) 

 Format #2: 

 CAN:9,CAN:13 

 (will generate status data for channels. 9 to 16) 

- From the Computed Data sub-module of Conf 
Pack, define two messages as follows: 

 <port>,<output mode>,<On/Off>,<rate>,1 

 <port>,<output mode>,<On/Off>,<rate>,2 
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 CHK: 

 Same as CRC except that CHK provides the complement of the 
parity processing. 

 

 CRC: 

 Computes the parity on all characters from the eth to the fth 
characters in the message. The result is a hexadecimal value 
expressed with two characters, transmitted along with the 
message 

 

 DAT: 

If c=1, then dd/mm/yyyy 

 c=2, then yyyy/mm/dd 

 c=3, then dd,mm,yyyy 

 The result occupies 9 or 10 characters, depending on day (1 or 2 
characters). A date with 10 characters will not be truncated if 
m=9 

 If m and c are not specified, default values are used (m=10 and 
c=1) 

 

 HEXA: 

 If m is not specified, then m=1 

 Leading spaces are added ahead of the result if too many 
characters have been reserved 

 Overflow condition not reported with this operator 
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 IF: 

 $ can be one of the following six relation operators: 

 < 

 > 

 ≥ 

 ≤ 

 = 

 < > 

 f1 and f2 are formats each bound by braces. 

 Example: IF(SOG<20){KN(SM):5:1}{'$$.$$'} 

 

 

 SIGN: 

 If x ≥ 0, then the result is p 

 If x < 0, then the result is q 

 If p and q are not specified, the following notation is used: 

p = {space} 
q = {hyphen} 
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 TXT: 

 The following variables can be combined with this operator, thus 
issuing the following character strings (within quotation marks 
below) depending on context: 

 
 Variables Output strings 
 DATM "WGS84", "<Datum Name>" 

 DFT ".GPS.", "DGPS1", "DGPS2", "DGPS3", "DGPS4", 
"MDGPS", "EDGPS", "KINEA", "KINER", "GNOS", 
"WDGPS"  

 DS "DIFF", "NAT", "HOLD" 

 FIXS "GOOD", "BAD" 

 INTEGAP "YES", "NO"  

 MODE "H", "DR", "T", "2", "2T", "3", "3T" 

 NSVU Lists all the SVs used (e.g. 3, 5, 12, 17, 24, 27) 

 SA "ON", "OFF" 

 SALARM see page 6-44 

 ULA to ULD "<Port A label>",... to  "<Port D label>" 

 

 ZERO: 

 Inserts zeros ahead of the x variable if there is room, with n and d 
defining the notation of the variable (or expression). There are no 
default values for n and d, as the function is irrelevant unless n 
and d are specified. 
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Macros 

��Macros list 
 ALM:n:d GPS almanac data 
 BEC:n:d Bearing and Distance to Waypoint (DR) (*) 
 BOC:n:d Bearing and Origin to Destination (*) 
 BWC:n:d Bearing and Distance to Waypoint (*) 
 DTM:n:d Datum Reference 
 GBS:n:d GPS Satellite Fault Detection (*) 
 GGA:n:d GPS Fix Data 
 GLL:n:d Lat-Long Geographic Position 
 GRS:n:d GPS Range Residual 
 GSA:n:d GPS DOP and Active Satellite 
 GST:n:d GPS Pseudorange Noise Statistics 
 GSV:n:d GPS Satellites in View 
 HDT:n:d Heading, True (*) 
 RMB:n:d Recommended Minimum Navigation Information (*) 
 RMC:n:d Recommended Minimum Specific GPS Data 
 TTL:n:d Target Latitude and Longitude (*) 
 VTG:n:d Course Over Ground and Ground Speed 
 WCV:n:d Waypoint Closure Velocity (*) 
 WNC:n:d Distance to Waypoint (*) 
 WPL:n:d Waypoint Location (*) 
 XTE:n:d Cross Track Error, Measured (*) 
 XTR:n:d Cross Track Error, Dead-Reckoning (*) 
 ZDA:n:d Time & Date 
 ZDL:n:d Time and Distance to Variable Point (*) 
 ZFO:n:d UTC and Time from Origin Waypoint (*) 
 ZTG:n:d Origin and Time to Destination Waypoint (*) 

 
 
 (* : Available at a later date) 
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��Syntax 
All macros are in the form: 

XXX:n:d 
 

where: 

 XXX Macro name (3 letters) 
 n Basically, n defines the number of decimal places for values 

of angles expressed in minutes (see detail in each macro). 
Indirectly, n also controls the number of decimal places for 
values of distances expressed in meters (number of decimal 
places= n −3 for n > 3) and for values of speed expressed in 
meters/second (number of decimal places= n −4 for n > 4). 

  If omitted, n is assumed to be 0 (except in GSA and ZDA 
where it is equal to 2). 

  Although n has no function in some macros it must be 
present when the checksum has to be placed at the end of 
the output string. With such macros, any value can be used 
for n. 

 d Checksum code: 
   d = 0 → no checksum at the end of the output string 
   d = 1 → checksum added at the end of the output 

string 
  If omitted, d is assumed to be 0. 
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Use precautions: 

Several macros can be chained to form a message. Remember however 
that the generated message should not exceed 511 characters in length. 

 

Examples: 

GGA:2:1 Global Positioning System Fix Data, 2 decimal places for 
variables expressed in minutes; checksum provided. 

ALM:1 First 5 almanacs; no checksum 
 

��ALM:n:d 
The output string is in the form: 

$GPALM,x.x,x.x,xx,x.x,hh,hhhh,hh,hhhh,hhhh,hhhhhh,hhhhhh,hhhhhh,
hhhhhh,hhh,hhh*hh<cr><lf> 

 

$GPALM : NMEA0183 message identifier 
x.x : Total number of messages 
x.x : Message number  
xx : Satellite PRN number 01..32 
x.x : GPS week number 
hh : SV health 
hhhh : e, eccentricity 
hh : toa, almanac reference time 
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hhhh : (sigma)i, inclination angle 
hhhh : OMEGADOT, Rate of right ascension 
hhhhhh : Root (A), root of semi major axis 
hhhhhh : Ω, argument of perigee 
hhhhhh : Ω0, longitude of ascension node 
hhhhhh : M0, mean anomaly 
hhh : af0, clock parameter 
hhh : af1, clock parameter 

*hh : Checksum, if requested (d=1) 
 
 
 

Output String Example: 

$GPALM,27,1,01,982,00,21CB,7B,08E0,FD40,A10D57,BAEB05,435714,
BD2E73,00C,080 
$GPALM,27,2,02,982,00,9603,7B,FCEB,FD4A,A10CE9,A4C0D6,957F28,
04E8E1,FF6,B7F 
$GPALM,27,3,03,982,00,0B52,7B,0368,FD21,A10D06,60E6B4,C18F80,7
7A2A7,02D,080 
$GPALM,27,4,04,982,00,2752,7B,16D8,FD43,A10CFD,DFD64E,EDD6E1
,659931,19E,190 
$GPALM,27,5,05,982,00,0B1C,7B,FED2,FD4B,A10E1E,F40F7A,963923,
6EE9AB,00F,160 
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Comments: 

You cannot output all the almanacs through a single macro, due to 
the size of the formatter buffer which is limited to 512 characters. 
Instead, define a value for n to tell the formatter which group of 
almanacs must be output through the macro (the output string then 
consists of about 400 characters). 
ALM :1 initializes the acquisition of all the almanacs and outputs 

the first 5 almanacs (or the existing 1 to 5 ones) 
ALM :1 must be run before running any macro of the type ALM :n 

(where n=2..7) 
ALM :2 outputs 6th to 10th almanacs for SVs 6 to 10 (if any) 
ALM :3 outputs 11th to 15th almanacs (if any) 
ALM :4 outputs 16th to 20th almanacs (if any) 
ALM :5 outputs 21st to 25th almanacs (if any) 
ALM :6 outputs 26th to 30th almanacs (if any) 
ALM :7 outputs 31st and 32nd almanacs (if any) 
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��DTM:n:d 
The output string is in the form: 

$GPDTM,ccc,,x.x,a,x.x,a,x.x,ccc*hh<cr><lf> 
 

$GPDTM : NMEA0183 message identifier 
ccc : Local datum code : WGS84 = W84, User defined = 999 
x.x,a : Latitude offset, in minutes (number of decimal places 

controlled by n), N/S 
x.x,a : Longitude offset, in minutes (number of decimal places 

controlled by n), E/W 

x.x : Altitude offset, in meters (number of decimal places= n−3 
if n>3) 

ccc : Reference datum code : WGS84 = W84 

*hh : Checksum, if requested (d=1) 
 

Output String Example: 

$GPDTM,W84,,0.000,N,0.000,E,0,W84*71 
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��GGA:n:d 
The output string is in the form: 

$GPGGA,hhmmss.ss,llll.lllll,a,yyyyy.yyyyy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxx
x*hh<cr><lf> 

 
Field type  Variable  Field Designation 
$GPGGA :  : NMEA0183 message identifier 
hhmmss.ss : TUTC : UTC time of position computation (2 

decimal places) 
llll.l ,a : LAT : Latitude in degrees (2 char.), minutes (2 

char.), fraction of a minute (number of 
decimal places controlled by n), N/S 
indicator 

yyyyy.y,a : LON : Longitude degrees (3 char.), minutes (2 
char.), fraction of a minute (number of 
decimal places controlled by n), E/W 
indicator 

x : DS : GPS quality figure : 
    0 : fix not available, or invalid 
    1 : straight GPS fix 
    2 : Differential GPS fix 
    4 : Real Time Kinematic (KINE A, KINE R, 

LRK or LRKW) 
    5 : Real Time Kinematic (EDGPS, KART 

or LRK initialization) 
    6 : Estimated (dead reckoning) mode 
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xx : NSVU : Number of SVs used to compute the fix 
x.x : HDOP : Horizontal Dilution of Precision  
    (-1 if not computed) 
x.x,M : HP : Antenna altitude above MSL, in meters (if MSL 

≠ 0) (number of decimal places= n−3 if n >3, 
otherwise (n<3) no decimal places). If MSL = 0, 
ZP is the altitude above the WGS84 

x.x,M : MSL : Geoidal separation (between ellipsoid and 
Mean Sea Level) (number of decimal places= 
n−3 if n >3, otherwise (n<3) no decimal 
places) 

x.x : DAGE : Age of Differential corrections, on average (null 
field if DGPS not used) (number of decimal 
places controlled by n) 

xxxx : DSTA : Identification of reference station used (null 
field if not used). 

*hh   : Checksum, if requested (d=1) 
 
Example: 

$GPGGA,192348.99,4716.10435,N,00129.45430,W,4,09,1.1,93.83,M,0.00,
M,2.0,0055*5C 
$GPGGA,192349.99,4716.10435,N,00129.45430,W,4,09,1.1,93.79,M,0.00,
M,3.0,0055*5D 
$GPGGA,192350.99,4716.10435,N,00129.45430,W,4,09,1.1,93.78,M,0.00,
M,2.0,0055*51 
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��GLL:n:d 
The output string is in the form: 

$GPGLL,llll.l,a,yyyyy.y,a,hhmmss.ss,A,a *hh<cr><lf> 
Field type  Variable  Field Designation 

$GPGLL   : NMEA0183 message identifier 
llll.l,a : LAT : Latitude in degrees (2 char.), 

minutes (2 char.), fraction of a 
minute (number of decimal places 
controlled by n), N/S indicator 

yyyyy.y,a : LON : Longitude in degrees (3 char.), 
minutes (2 char.), fraction of a 
minute (number of decimal places 
controlled by n), E/W indicator 

hhmmss.ss : TUTC : UTC time of position computation (2 
decimal places) 

A : FIXS : GPS quality figure 
V = Fix not available, or invalid 
A = GPS fix available 
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a  : Mode indicator: 
A = Autonomous mode

     D = Differential mode 
     E = Estimated (dead reckoning) 

mode 
     N = Data not valid 

*hh   : Checksum, if requested (d=1) 
 

Example: 

$GPGLL,4716.10435,N,00129.45430,W,192531.99,A,D*70 
$GPGLL,4716.10435,N,00129.45430,W,192532.99,A,D*71 
$GPGLL,4716.10435,N,00129.45430,W,192533.99,A,D*7E 
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��GRS:n:d 
The output string is in the form: 

$GPGRS,hhmmss.ss,1,x.xx,x.xx,x.xx,x.x,.......,,,*hh <cr><lf> 
Field type  Variable  Field Designation 

$GPGRS   : NMEA0183 message identifier

hhmmss.ss : TUTC : UTC time (2 decimal places) 

1   : This “1” means that residuals were re-
computed after the GGA GNS position 
was computed 

x.x : CRE[ i ] : Range residuals in meters for satellites 
used in the navigation solution (null for 
unused field) (number of decimal places 
controlled by n), 

*hh   : Checksum, if requested (d=1) 

 
Example: 

$GPGRS,143322.99,1,10.34,,3.40,0.12,-24.49,-0.91,-6.47,6.90,,27.81,-
16.70,,,,,*46 
$GPGRS,143323.99,1,10.56,,3.46,0.11,-24.81,-0.77,-6.55,7.01,,28.03,-
16.82,,,,,*42 
$GPGRS,143324.99,1,10.71,,3.44,0.09,-25.23,-0.49,-6.72,7.08,,28.12,-
16.92,,,,,*4C 
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��GSA:n:d 
The output string is in the form: 

$GPGSA,A,x,xx,xx,xx,xx,xx,xx,xx,xx,xx,xx,,,,,,, 
x.x,x.x,x.x*hh <cr><lf> 

Field type  Variable  Field Designation 

$GPGSA   : NMEA0183 message identifier 
A   : 2D/3D automatic switching mode 
x : MODE : Fix mode 

    1 = invalid fix 
    2 = 2D mode 
    3 = 3D mode 

xx,...,xx : NSVU : PRN of SVs used in the solution (use n=3 to 
issue a 3-figure PRN; if omitted, n=2) 

x.x : PDOP : Position DOP (-1.0 if not computed) 
x.x : HDOP : Horizontal DOP (-1.0 if not computed) 
x.x : VDOP : Vertical DOP (-1.0 if not computed) 

*hh   : Checksum, if requested (d=1) 
 
Example: 

$GPGSA,A,3,24,18,25,07,15,19,16,,04,14,,,,,,,,,2.0,1.1,-1.0*19 
$GPGSA,A,3,24,18,25,07,15,19,16,,04,14,,,,,,,,,2.0,1.1,-1.0*19 
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��GST:n:d 
The output string is in the form: 

$GPGST,hhmmss.ss,,,,,x.xx,x.x,x.x*hh <cr><lf> 

Field type  Variable  Field Designation 

$GPGST   : NMEA0183 message identifier
hhmmss.ss : TUTC : UTC time (2 decimal places) 
,,,,,   : Null fields 
x.x : NPSD : Standard deviation of latitude error (meters) 

(number of decimal places controlled by n) 
x.x : EPSD : Standard deviation of longitude error (meters) 

(number of decimal places controlled by n) 
x.x : HPSD : Standard deviation of altitude error (meters) 

(number of decimal places controlled by n) 

*hh   : Checksum, if requested (d=1) 
 
Example: 

$GPGST,080154.99,,,,,0.02,0.02,0.03*6C 
$GPGST,080155.99,,,,,0.02,0.02,0.04*6A 
$GPGST,080156.99,,,,,0.02,0.02,0.03*6E 
$GPGST,080157.99,,,,,0.02,0.02,0.04*68 
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��GSV:n:d 
The output string is in the form: 

$GPGSV,x,x,xx,xx,xx,xxx,xx.................,xx,xx,xxx,xx*hh 
<cr><lf> 

 
Field type  Variable  Field Designation 

$GPGSV   : NMEA0183 message identifier 

x   : Total number of messages 

x   : Message number 

xx : NSVR : Total number of satellites in view 

xx : CSV[ i ] : Satellite ID number 

xx : CEL[ i ] : Elevation, in degrees (90 max.) 

xxx : CAZ[ i ] : Azimuth, in degrees, True (0 to 359) 

xx : CSB[ i ] : SNR (C/No) (00 to 99 dB-Hz) 

*hh   : Checksum, if requested (d=1) 
 

The last four parameters are provided for each satellite in view. Depending 
on the number of satellites in view, the message can occupy up to 3 lines. 

Example: 

$GPGSV,3,1,10,24,13,313,41,18,61,206,50,25,07,031,38,07,29,234,43*72 
$GPGSV,3,2,10,15,08,136,41,19,09,168,39,16,78,020,50,13,03,222,37*78 
$GPGSV,3,3,10,04,53,303,49,14,41,077,47*74 
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��RMC:n:d 
The output string is in the form: 

$GPRMC, hhmmss.ss,a,llll.l,a,yyyyy.y,a, 
x.x,x.x,xxxxxx,,,a*hh <cr><lf> 
Field type  Variable  Field Designation 

$GPRMC   : NMEA0183 message identifier 
hhmmss.ss : TUTC : UTC time (2 decimal places) 
a : FIXS : GPS quality figure

V = Fix not available, or invalid 
A = GPS fix available 

llll.l,a : LAT : Latitude in degrees (2 char.), minutes (2 
char.), fraction of a minute (number of 
decimal places controlled by n), N/S 
indicator 

yyyyy.y,a : LON : Longitude in degrees (3 char.), minutes (2 
char.), fraction of a minute (number of 
decimal places controlled by n), E/W 
indicator 

x.x : SOG : Speed Over Ground (knots) (number of 
decimal places= n−4 if n >4, otherwise 
(n<4) no decimal places) 

x.x : COG : Course Over Ground (in degrees) 
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xxxxxx   : Date (ddmmyy) 
a  : Mode indicator: 

A = Autonomous mode
     D = Differential mode 
     E = Estimated (dead reckoning) 

mode 
     N = Data not valid 

*hh   : Checksum, if requested (d=1) 
 

Example: 

$GPRMC,193612.99,A,4716.10435,N,00129.45430,W,0.0,0.0,041198,,,D*
64 
$GPRMC,193613.99,A,4716.10435,N,00129.45430,W,0.0,0.0,041198,,,D*
65 
$GPRMC,193614.99,A,4716.10435,N,00129.45430,W,0.0,0.0,041198,,,D*
61 
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��VTG:n:d 
The output string is in the form: 

$GPVTG,x.x,T,x.x,N,x.x,K,a*hh<cr><lf> 

Field type  Variable  Field Designation 

$GPVTG   : NMEA0183 message identifier 

x.x,T : COG : Course Over Ground (in degrees) 

x.x,N : SOG : Speed Over Ground (in knots) (number of 
decimal places controlled by n) 

x.x,K : SOG : Speed Over Ground (in km/hr) (number of 
decimal places controlled by n) 

a  : Mode indicator: 
A = Autonomous mode

     D = Differential mode 
     E = Estimated (dead reckoning) 

mode 
     N = Data not valid 
*hh   : Checksum, if requested (d=1) 

 
Example: 

$GPVTG,120.4,T,,,5.74,N,10.63,K,D*45 
$GPVTG,119.1,T,,,5.81,N,10.76,K,D*4E 
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��ZDA:n:d 
The output string is in the form: 

$GPZDA,hhmmss.ss,xx,xx,xxxx,xx,xx*hh<cr><lf> 
Field type  Variable  Field Designation 
  (ConfPack) 

$GPZDA    NMEA0183 message identifier

hhmmss.s : TUTC : UTC time (number of decimal 
places controlled by n) 

xx,xx,xxxx : DUTC : UTC date (day, month, year) 

xx   : Local zone hours (00 to ± 13 
hr) 

xx   : Local zone minutes (00 to + 
59) 

*hh   : Checksum, if requested (d=1) 

 
 
Example: 

$GPZDA,075448.99,04,11,1998,+00,00*4A 
$GPZDA,075449.99,04,11,1998,+00,00*4B 
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Variables 

��Time Data 
 DP Local Date (yyyymmdd) (*) 
 DUTC UTC Date (yyyymmdd) (*) 
 GPSD GPS - UTC time deviation, in seconds 
 GPST GPS time in week, in seconds (*) 
 GPSW GPS time week number 
 TP Local Time, in seconds (*) 
 TUTC UTC Time, in seconds (*) 

(*) : Interpolated variable 

 

��Position Data 
 L84 WGS84 Latitude, in radians (**) 
 G84 WGS84 Longitude, in radians (**) 
 H84 Altitude above WGS84 ellipsoid, in meters (**) 
 L84AVR Averaged WGS84 Latitude, in radians 
 G84AVR Averaged WGS84 Longitude, in radians 
 H84AVR Averaged altitude above WGS84 ellipsoid, in meters 
 X84 ECEF WGS84 Position, X coordinate, in meters (**) 
 Y84 ECEF WGS84 Position, Y coordinate, in meters (**) 
 Z84 ECEF WGS84 Position, Z coordinate, in meters (**) 
 X84SD X component of standard deviation on ECEF WGS84 

average position, in meters 
 Y84SD Y component of standard deviation on ECEF WGS84 

average position, in meters 
 Z84SD Z component of standard deviation on ECEF WGS84 average 

position, in meters 
(**) : Extrapolated variable except for accurate solution 
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��Speed Data 
 COG Course Over Ground, in radians 
 P Clock Offset, in seconds 
 PS Clock drift speed, in seconds per second 
 SOG Speed Over Ground, in meters/second 
 XS Speed East component, in meters/second 
 YS Speed North component, in meters/second 
 ZS Speed vertical component, in meters/second 

 

��Position status 
 CRE[i] Residuals, in meters (i: channel number, 1 to 16) 
 CRS[i] Residuals speed, in meters/second (i: channel number, 1 

to 16) 
 DRMS Deviation Root Mean Square, in meters (−1: not available) 
 DRT Time elapsed since last fix, in seconds (if MODE=1) 
 FIXS Position status:  
 1 "GOOD" (computed) 
 0 "BAD" (not computed) 
  The string within quotation marks can be issued using the 

TXT:FIXS combination 
 GDOP Geometrical DOP (−1: not available) 
 HDOP Horizontal DOP (−1: not available) 
 TDOP Time DOP (−1: not available) 
 PDOP Position DOP (−1: not available) 
 VDOP Vertical DOP (−1: not available) 
 LPME Lines of position mean error, in meters (−1: not available) 
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 M[ ] Fix Variance/Covariance Matrix, in meters² 
  M[1]= Latitude variance 
  M[2]= Latitude/longitude covariance 
  M[3]= Longitude variance 
  M[4]= Latitude/altitude covariance 
  M[5]= Longitude/altitude covariance  
  M[6]= Altitude variance  
  M[7]= Latitude/clock covariance  
  M[8]= Longitude/clock covariance  
  M[9]= Altitude/clock covariance  
  M[10]= Clock variance 
 
 MODE Position processing mode: 
 0 "H" (Hold) 
 1 "DR" (Dead Reckoning) 
 2 "T" (Time) 
 3 "3T" (3D+T) 
 4 "3" (3D) 
 5 "2T" (2D+T) 
 6 "2" (2D) 
  The string within quotation marks can be issued using the 

TXT:MODE combination (operator:variable) 
 NSVR or NSVR1 Count of SVs received on L1 
 NSVR2 Count of SVs received on L2 
 NSVU Count of SVs used (List of PRN numbers of SVs used) 
  The list can be issued using the TXT:NSVU combination 

 
 QUAL Fix confidence level 
  0..3= Straight GPS 
  4..5= 2D+T DGPS 
  6..9= 3D+T DGPS  
  10..13= EDGPS 
  14..19= KINE 
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 SA Selective Availability flag: 
 1 "ON" (SA on) 
 0 "OFF" (SA off) 
  The string within quotation marks can be issued using the 

TXT:SA combination  
 SVU[i] PRN of the SVs involved in the position processing (i: 

channel number, 1 to 16). 
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��External Integrity Control 
 INTEGAP Indicates whether External integrity control is used. Must be 

combined with the TXT operator. The possible output strings 
are then the following (mentioned within quotation marks): 

  "YES" (external integrity control used) 
  "NO" (external integrity control not used) 
 INTEGID Identification of the source of integrity data (GEO PRN if In-

tegrity Control from WAAS, -1 if no integrity control) 
 INTEGST[i] Integrity control result (i: channel number, 1.. 16): 
  0 (unmonitored) 
  1 (unhealthy) 
  2 (healthy) 
 
 UDRE[i] Value of UDRE for each channel (i: chan. No., 1.. 16). 
 
 
��GNSS Status 
 CAZ[i] SV azimuth, in radians (i: channel number, 1 to 16) 
 CEL[i] SV elevation, in radians (i: channel number, 1 to 16) 
 CIO[i] Ionospheric correction, in meters (i: channel number, 1 to 16) 
 CRD[i] Ascending or descending satellite, in radians (i: channel 

number, 1 to 16): 
 0 (descending) 
 1 (ascending) 
 CTR[i] Tropospheric correction, in meters (i: channel number, 1 to 

16) 
 CSB[i] C/N0 level, in dB (i: channel number, 1 to 16) 
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 CST[i] Channel status (i: channel number, 1 to 16): 
 0 (free channel) 
 1 (channel used, SV received on this channel) 
 2 (channel used, no SV received on this channel or SV 

lost) 
 3 (same as 1 + ephemeris received on this channel) 
 4 (same as 3 + channel involved in fix processing) 
 5 (channel searching for SV) 
 6 (channel deselected manually) 
 7 ( channel rejected by WAAS integrity control) 
 CSV[i] PRN of the SV received on that channel (i: channel number, 1 

to 16). 
 
 
��DGPS Status 

 CCS[i] or CCS1[i]  L1 DGPS corrections availability (i: channel number, 1 to 16) 
 0 (not available) 
 1 (available) 

 CCS2[i]  L2 DGPS corrections availability (i: channel number, 1 to 16) 
 0 (not available) 
 1 (available) 
 DAGE Age of DGPS corrections, on average, in seconds 
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 DFT Type of DGPS used: 
 -1 “HOLD” 
 0 "GPS" 
 1 "DGPS1" 
 2 "DGPS2" 
 3 "DGPS3" 
 4 "DGPS4" 
 5 "MDGPS" 
 6 "EDGPS" 
 7 “<blank>“ (Unassigned) 
 8 "KINE" (KART) 
 9 " EDGP1" (KART initialization) 
 20 "GNOS" 
 25 "WDGPS" 
 31 "LRK" 
 32 "EDGP2" (LRK initialization) 
 33 "WL" (LRK WL) 
 34 "EDGP2" (LRK WL initialization) 
  The string within quotation marks can be issued using the 

TXT:DFT combination. 
 DRCV DGPS reception quality 
 DS DGPS Status: 
 0 "NOFIX" (no position solution) 
 1 "AUTO" (straight GPS solution) 
 2 "DGPS" (DGPS solution) 
 3 “PREC” (for future use) 
 4 “RTK“ (KART, LRK or LRK WL solution) 
 5 “FRTK “(EDGPS solution) 
 6 “ESTIM” (dead reckoning) 
 7 “MANU” (Manual input mode) 
 8 “SIMUL” (Simulation mode) 
  The string within quotation marks can be issued using the 

TXT:DS combination  
 

 DSTA Identification of the DGPS station used 
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��Current Position 
 DATM Identification of the transformation system used: 
 0 "WGS84" 
 1..9 "<datum name>" 
  The string within quotation marks can be issued using the 

TXT:DATM combination (10 characters max.) 
 EPAVR Averaged Easting, from PVT (1) processing 
 EPSD Standard deviation of average Easting, from PVT(1) 

processing 
 HPAVR Averaged user altitude, in the chosen mode, in meters 
 HPSD Standard deviation of averaged user altitude, in the chosen 

mode, in meters. 
 LAT Latitude, from PVT (1) processing, expressed on the datum of 

the transformation system used, in radians (2) 
 LON Longitude, from PVT (1) processing, expressed on the datum 

of the transformation system used, in radians (2) 
 NP Northing, from PVT (1) processing, expressed in the 

transformation system used (2) 
 EP Easting, from PVT (1) processing, expressed in the 

transformation system used (2) 
 HP User altitude, expressed in the chosen mode, in meters (2) 

 NPAVR Averaged Northing, from PVT (1) processing 
 NPSD Standard deviation of averaged Northing, from PVT(1) 

processing 
 PGPSW GPS week number, from PVT (1) processing 
 PGPST GPS time in week, from PVT (1) processing 
 
  (1) PVT : French acronym for Position-Speed-Time 
  (2) Extrapolated variable (except if an accurate solution) 
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��Kinematic Data 
 AGESOL Time elapsed since last solution found 

 EPKASD Easting uncertainty (DRMS), accurate solution 
 NPKASD Northing uncertainty (DRMS), accurate solution 
 HPKASD Altitude uncertainty (DRMS), accurate solution  

 EPKRSD Easting uncertainty (DRMS), real-time solution 
 HPKRSD Altitude uncertainty (DRMS), real-time solution 
 NPKRSD Northing uncertainty (DRMS), real-time solution  

  MKIN Kinematic Mode: 
 1 (EDGPS) 
 2 (INIT KART) 
 3 (INIT LRK) 
 4 (KART) 
 5 (LRK) 
 NBSOL Count of solutions found 
 NSVUK Count of satellites used 
 TINIT Time elapsed since initialization was started (in seconds) 
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��Station Data 
(i= count of stations, 1 to 4) 

 DSTSTA[i] Distance between reference station and mobile, in meters 
 NIVUHF[i] UHF reception level, in dB 
 REFUHF[i] Station ID 
 UBUHF[i] DC voltage delivered by the battery used at the station, in 

volts 
 ESTA[i] Easting of reference station 
 NSTA[i] Northing of reference station 
 HSTA[i] Altitude of reference station expressed on the user’s geodetic 

system, in meters 
 GSTA[i] WGS84 longitude of reference station, in radians 
 LSTA[i] WGS84 latitude of reference station, in radians 
 X84STA[i] WGS84 ECEF X coordinate of reference station’s antenna, in 

meters 
 Y84STA[i] WGS84 ECEF Y coordinate of reference station’s antenna, in 

meters 
 Z84STA[i] WGS84 ECEF Z coordinate of reference station’s antenna, in 

meters 
 
 
��"Intermediate" Points Data 
 
 DAKA  Age of differential corrections involved in accurate solution, in 

seconds 
 DAKR  Age of differential corrections involved in real-time solution, in 

seconds 
 DBKA  Beacon ID involved in accurate solution 
 DBKR  Beacon ID involved in real-time solution 
 DKA UTC date of accurate solution (yyyymmdd) 
 DKR UTC date of real-time solution (yyyymmdd) 
 DQKA  Quality of differential reception in accurate solution (0..9) 
 DQKR  Quality of differential reception in real-time solution (0.. 9) 
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 DTKA  Accurate solution type: 
 0 (GPS) 
 1 (DGPS1) 
 2 (DGPS2) 
 3 (DGPS3) 
 4 (DGPS4) 
 5 (MDGPS) 
 6 (EDGPS) 
 7 (KINEA) 
 8 (KINER) 
 20 (GNOS) 
 25 (WDGPS) 
 DTKR Real-time solution type 
 0 (GPS) 
 1 (DGPS1) 
 2 (DGPS2) 
 3 (DGPS3) 
 4 (DGPS4) 
 5 (MDGPS) 
 6 (EDGPS) 
 7 (KINEA) 
 8 (KINER) 
 20 (GNOS) 
 25 (WDGPS) 

  NOTE: DTKA & DTKR cannot be combined with TXT 
 FDRKA DRMS of accurate solution, in meters 
 FDRKR DRMS of real-time solution, in meters 

 GKA WGS84 Longitude, accurate solution, in radians 
 LKA WGS84 Latitude, accurate solution, in radians 
 ZKA  Altitude from WGS84 ellipsoid, accurate solution, in meters 

 GKR WGS84 Longitude, real-time solution, in radians 
 LKR WGS84 Latitude, real-time solution, in radians 
 ZKR  Altitude from WGS84 ellipsoid, real-time solution, in meters 

 HDKA  Accurate solution HDOP 
 HDKR  Real-time solution HDOP 
 NKA Count of satellites used in accurate solution 
 NKR Count of satellites used in real-time solution 
 QKA  Accurate solution quality figure (0.. 9) 
 QKR  Real-time solution quality figure (0.. 9) 
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 SKA  Accurate solution status: 
  0 (invalid) 
  1 (valid) 
 SKR  Real-time solution status: 
  0 (invalid) 
  1 (valid) 
 TKA UTC time of accurate solution (no extrapolation made) 
 TKR UTC time of real-time solution (no extrapolation made) 

 
 

The following variables are still in use for compatibility with configuration 
files of the E2 type. The definition of the suffix [i] remains unchanged 
(compared to the former version of Conf Pack), as recalled below: 

 i=1→ MDGPS point 
 i=2→ EDGPS point 
 i=3→ KARTA point 
 i=4→ KARTR point 
 
 D[i] UTC Date (yyyymmdd) 
 DA[i]  Age of differential corrections, in seconds 
 DT[i]  Type of DGPS used: 
 0 (GPS) 
 1 (DGPS1) 
 2 (DGPS2) 
 3 (DGPS3) 
 4 (DGPS4) 
 5 (MDGPS) 
 6 (EDGPS) 
 7 (KINEA) 
 8 (KINER) 
 20 (GNOS) 
 25 (WDGPS) 
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 DB[i]  Beacon ID 
 DQ[i] Quality of differential reception (0.. 9) 
 HD[i]  HDOP 
 FDRM[i] DRMS, in meters. 
 L[i] WGS84 Latitude, in radians 
 G[i] WGS84 Longitude, in radians 
 Z[i]  Altitude from WGS84 ellipsoid, in meters 
 N[i] Count of satellites used 

 
 Q[i]  Quality figure: 
  Q[1]= 0..9 
  Q[2]= 10..13 
  Q[3]= 14..19 
  Q[4]= 14..19 

 
 S[i]  Position solution status: 
  0 (invalid) 
  1 (valid) 
 T[i] UTC Time 
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��Anomalies & Alarms 
 ALARM[i] Status of alarm i, where i: alarm number (1 to 128): 
 0 (no alarm or anomaly) 
 1 (status positioned to “active”, alarm or anomaly still 

persists) 
 2 (status still “active” but cause of alarm or anomaly has 

disappeared; alarm not acknowledged yet) 
 CALARM[i] Extra-code pertaining to anomaly or alarm (i: alarm number, 1 

to 128) 
 DALARM[i] Day when alarm or anomaly first occurred (i: alarm number, 1 

to 128) 
  DALARM[i]= 0..31 
 FALARM[i] Time when alarm or anomaly first occurred (i: alarm number, 

1 to 128) 
  FALARM[i]= 0..86399 seconds 
 LALARM[i] Time when alarm or anomaly last occurred (i: alarm number, 

1 to 128) 
  LALARM[i]= 0..86399 seconds (current time if alarm or 

anomaly still persisting) 
 SALARM Number of active alarms or anomalies (128 max.) 
  Combined with the TXT operator, provides the status of each 

of the alarms or anomalies in the form of a string of 32 ASCII-
encoded hex characters (the least significant bit corresponds 
to Alarm No. 1, the most significant bit to Alarm No. 128). Any 
bit =1 means that the corresponding alarm is active. 
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• Families of anomalies & alarms 
Alarms & anomalies are classified into families, depending on the probable 
origin of error. The table below summarizes the 11 different families 

Family 
number Origin Label 

00 No errors NONE 
01 Core Module CM 
02 Application Configuration CONFG 
03 DGPS DGPS 
04 Coordinate system GEODY 
05 Input/Output I/O 
06 User Interface IHM 
07 Power supply/interface  INTRF 
08 Navigation NAVIG 
09 Fix processing POSIT 
10 System SYSTM 
11 Data link TD 

 

• Classification 
Alarms & anomalies are classified into four categories depending on gravity: 

- Simple information reported to user (code 1) 

- Warnings (code 2). The receiver operates correctly but might be 
disturbed by the reported error. 

- Serious errors (code 3). The receiver operates but delivers 
erroneous results. 

- Fatal errors (code 4). The receiver can no longer operate 
correctly. You should re-initialize the receiver. 
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• Codes List 

No. Family Gra-
vity Meaning Label (for receivers fitted 

with display screens) 
01 1 - CM 4 GPS not ready GPS not ready 
02 1 - CM 4 RAM error RAM anomaly 
03 1 - CM 3 Processor error Processor anomaly 
04 1 - CM 3 Timing error Timing anomaly 
05 1 - CM 3 Program memory error Program memory anomaly 
06 1 - CM 3 Data memory error Data memory anomaly 
07 1 - CM 3 Reception circuit error Reception circuit anomaly 
08 1 - CM 3 Correlation circuit error Correlation circuit anom 
09 1 - CM 4 C/A-P/YCommunication error Communication C/A - P/Y 
10 1 - CM 2 Non-used output data Unread output datas 
11 1 - CM 2 Non-identified input data Unknown input datas 
12 1 - CM 2 Non-complying input data Bad input datas 
13 1 - CM 1 GPS data error GPS data anomaly 
14 1 - CM 1 DPRAM error DPRAM anomaly 
15 1 - CM 1 Erroneous message length Bad message length 
16 1 - CM 1 EEPROM error EEPROM anomaly 
17 1 - CM 3 Trigger time-tag error Datation Trigger Error 
18 2 - CONFG 4 Config integrity altered Bad config integrity 
19 2 - CONFG 3 Config parameter error Config parameter error 
20 3 - DGPS 3 No transmitting station No sending dtation 
21 3 - DGPS 3 CPU-DIFF overflow CPU-DIFF overflow 
22 4 - GEODY 3 Coordinate system error Geodesy error 
23 5 - I/O 2 Unknown remote command Unknown telecommand 
24 5 - I/O 2 Non-complying param. format Bad parameter format 
25 5 - I/O 2 Non-complying format block Bad block format 
26 5 - I/O 3 Command checksum error Bad telecommand checksum 
27 5 - I/O 3 DPR1 Input error Input error on DPR1 
30 5 - I/O 3 Non-complying LRK block Bad LRK block on port D 
31 5 - I/O 3 Port A Overflow  Overflow PortA 
32 5 - I/O 3 Port B Overflow Overflow PortB 
33 5 - I/O 3 Port C Overflow Overflow PortC 
34 5 - I/O 3 Port D Overflow Overflow PortD 
35 5 - I/O 2 Format interpretation error Format interpretation 
36 5 - I/O 3 Port A Input error Input error PortA 
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37 5 - I/O 3 Port B Input error Input error PortB 
38 5 - I/O 3 Port C Input error Input error PortC 
39 5 - I/O 3 Port D Input error Input error PortD 
40 6 - IHM 2 User Interface error IHM error 
41 7 - INTRF 4 Xilinx Load Xilinx Load 
42 7 - INTRF 4 Low Power Command Low Power Command 
43 7 - INTRF 3 PCMCIA overflow PCMCIA overflow 
44 7 - INTRF 3 File system full File system full 
45 7 - INTRF 2 PC board not recognized Unknown PC card 
46 7 - INTRF 4 Battery voltage too low Battery voltage 
47 7 - INTRF 3 Corrupted file system Corrupted file system 
48 7 - INTRF 4 First antenna error First antenna error 
52 7 - INTRF 3 File-opening error File open error 
53 7 - INTRF 3 File-closing error File close error 
54 7 - INTRF 3 File-writing error File write error 
55 7 - INTRF 3 File-reading error File read error 
56 8 - NAVIG 3 Navigation error Navigation error 
57 9 - POSIT 1 No differential reception No differential reception 
58 9 - POSIT 1 Too few Svs Too few Svs 
59 9 - POSIT 1 GDOP too high GDOP too high 
60 9 - POSIT 3 LPME too high LPME too high 
61 9 - POSIT 1 No fix computation No fix computation 
62 10 - SYSTM 2 Frozen display Frozen display 
63 10 - SYSTM 2 Unknown option code Unknown option code 
64 10 - SYSTM 4 C3 codes checksum error Bad checksum codes C3 
65 10 - SYSTM 2 Log checksum error Bad log checksum 
66 10 - SYSTM 4 Real-time clock Real Time Clock 
67 10 - SYSTM 4 Dual-port RAM Dual port RAM 
68 11 - SYSTM 4 Core module not ready Core module not ready 
69 10 - SYSTM 4 Program checksum error Bad program checksum 
70 10 - SYSTM 4 Data memory test Data memory test 
71 10 - SYSTM 4 Coprocessor test Coprocessor test 
72 10 - SYSTM 4 Serial port error Error on serial port 
73 10 - SYSTM 3 IDE file system mounting error File system IDE mount err 
74 10 - SYSTM 1 Option lending period has now 

elapsed 
Option no more available 

75 10 - SYSTM 4 Max. number of tries reached Max option tries reached 
76 10 - SYSTM 1 Journal full Full anomalies journal 
77 10 - SYSTM 3 CMOS date failed CMOS date Failed 
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78 11 - TD 4 Selftest error Autotest error 
79 11 - TD 3 Erroneous blocks Bad blocks 
80 11 - TD 1 Count of restarts since selftest Nb restart since autotest 
81 10 - SYSTM 3 Mailbox overflow Mailbox overflow 
82 10 - SYSTM 3 PCMCIA removed PCMCIA removed 
83 5 - I/O 3 DPR1 Overflow Overflow DPR1 
86 POSIT 3 Kinematic initialization Kinematic initialization 
87 10 - SYSTM 3 Line in CM file too long Line file CM too long 
88 10 - SYSTM 3 CM identification error Identification CM error 
89 10 - SYSTM 3 CM card file inconsistency Incoherence file card CM 
90 10 - SYSTM 3 Flash CM clear error Clear flash CM error 
91 10 - SYSTM 3 CM program loading error CM program file load error 
92 6 - IHM 3 Kinematic mode change Kinematic mode change 
93 6 - IHM 3 No position computed No computed position 
94 7 - INTRF 4 Binary file inconsistency  Binary file incoherent  
95 10 - SYSTM  RTC send error RTC send error 
96 4 - GEODY  Altimetry error Altimetry error 
97 10 - SYSTM  Application software Re-load error Appli soft reload error 
98 10 - SYSTM 4 Protected memory error Back memory failure 
99 10 - SYSTM 4 Stack overflow Stack overflow 
100 5 - I/O 2 Error on port A in reception Receiving error on port A 
101 5 - I/O 2 Error on port B in reception Receiving error on port B 
102 5 - I/O 2 Error on port C in reception Receiving error on port C 
103 5 - I/O 2 Error on port D in reception Receiving error on port D 
104 10 - SYSTM 1 Unexpected software error Software error 

 
In case of a reported code number not mentioned in the above list, please 
contact THALES Navigation for more information. 
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��Other Variables 
 
 DAVR Averaging duration 
 DENR Time (in s) elapsed since beginning of data recording on PC 

card (“0” if no recording in progress) 
 MAVR Averaging process mode (only relevant to a transmitting 

station) 
 0 At initialization 
 1 Averaging process in progress 
 2 Averaging process complete 

 MSL Mean Sea Level (Distance deviation between user geoid and 
WGS84 ellipsoid). Forced to 9999.0 m if user altitude cannot 
be determined) 

 NBAVR Count of values involved in the averaging process 
 NBCOR Count of computed corrections (only relevant to a station 

computing corrections) 
 PCA Memory space currently available on PC card (PCMCIA), in 

bytes 
 PCS Total memory space on PC card, in bytes 
 UB Battery voltage 

 ULA, ULB 
 ULC, ULD 
 ULP User labels on ports A to D, and P (PC card) (initialized by the 

TR command). Must be combined with the TXT operator 

 UV[i] User variables (i: 1 to 10) 

  ♣ 
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7. Review of the Conf Pack Commands 

File menu 

The File menu offers the following commands: 

 
 New Creates a new configuration file or template 

 Open.. Opens an existing configuration file or template 

 Close Closes the active configuration file or template 

 Save Saves the active configuration file or template 

 Save As... Saves the active configuration as a .cfg file, a .txt file or a 
template (.tpl file) 

 Print Prints the content of the currently active pane. If the 
Select Pane is active, then the configuration file as such is 
printed (i.e. a list of receiver-interpretable command lines) 

 Print Preview Displays the content of the currently active pane as it 
would appear printed. If the Select Pane is active, then 
the configuration file as such is displayed (i.e. a list of 
receiver-interpretable command lines) 

 Print Setup... Selects a printer and printer connection 

 {File list} Names of the configuration files last opened using Conf 
Pack 

 Exit Exits Conf Pack 
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Edit menu 

The Edit menu offers the following commands: 
 

 Cut Moves the current selection to the clipboard 

 Copy Copies the current selection to the clipboard 

 Paste Pastes the clipboard content where the insertion point is 
positioned. 

 

View menu 

The View menu offers the following commands: 
 

 Toolbar Shows/hides the toolbar 

 Status bar Shows/hides the status bar 

 

Transfer menu 

The Transfer menu offers the following commands: 
 

 Read Current Reads the current configuration file from the attached 
receiver 

 Read Initial Reads the initial configuration file from the attached 
receiver 

 Write Initial Writes an initial configuration into the attached receiver 
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Tools menu 

The Tools menu offers the following commands: 
 

 Win Comm Starts the Win Comm software 

 Unprotect Launches the Unprotect Software  Component 

 Geoids Launches the Geoids module 

 Options Allows you to display/change the options of Conf Pack 

 

Window menu 

The Window menu offers the following commands: 
 

 Cascade Arranges all the open windows in cascade configuration 

 Tile 
 Horizontally Places all the open windows side by side in the horizontal 

direction 

 Tile Vertically Places all the open windows side by side, in the vertical 
direction 

 Close All Closes all the open configuration files 

 {File list} The names of the currently open configurations are listed 
here to let the user choose the active configuration di-
rectly from this menu 
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Help menu 

The Help menu offers the following commands, which provide you 
assistance with this application:  

 Contents Displays the opening screen of Help (first page of PDF 
help document) 

 About 
 Conf Pack Displays the version number of Conf Pack. ♣ 



ConfPack Reference Manual 
Index 

 i-1 

" 

"Intermediate" points data (variables), 
6-40 

3 

3SPack, 2-3, 3-6, 3-10 

A 

Add Request button, 4-14 
Almanacs, 5-15 
Altitude computation mode, 5-5 
Altitude, offset, 5-5 
Anomalies & alarms 

list, 6-46 
Appearance, 5-18 
Auto Configure, 2-15 
Automatic File Name option, 4-14 
Autonomous QC, 5-10 
AUTPW, 5-26 

B 

Band. 1, 5-28 
Beacon ID, 5-28, 5-30 
Beacons, 5-28 

Create, 3-14 
Range, 3-15 

Bearing, 5-24 
BEARING, 5-23 
Bin directory, 1-4 
Bit flow, 5-16 

C 

C3 code, 5-28 
CAN, 6-8 
CD-ROM, 1-2 
Central Meridian, 5-4 
Central or North Lat, 5-4 
Cfg directory, 1-4 
CHK, 6-10 
Cmd directory, 1-4 
Command 

Add, 4-7, 4-8 
Delete, 4-8 
Load, 4-8 
Save, 4-8 
Send, 4-6 

Comment, 5-2 
Communications, port settings, 5-11 
Computed Data, 5-12 
Control characters, 6-5 
Coord. System, waypoints, 5-19 
Coordinate Systems, 5-3 
CRC, 6-10 
Create 

Beacons, 3-13 
New configuration file, 3-1 
New template, 3-2 
Routes, 3-11 
Waypoint, 3-9 

Current configuration, 2-1 
Current Coord. System, 5-5 
Current Position (variables), 6-38 

D 

DAT, 6-10 

Index



ConfPack Reference Manual 
Index 

i-2  

Default configuration, 2-1 
default template, 3-4 
Delete Request button, 4-14 
Deselected SVs, 5-6 
DGNSS data, 5-31 
DGPS reference station, position, 5-6 
DGPS Status (variables), 6-36 
Display Pane / Window, 4-16 
Distance Unit, 5-18 
dongle, 1-5 

E 

Edit Pane, 2-5 
Editor table, 2-5 

Cell types, 2-9 
cells, 2-8 
Editing instructions, 2-11 
Status column, 2-8 
top row, 2-8 

Encryption, 5-28 
Ephemerides, 5-15 
Event Edge, 5-17 
External QC, 5-10 
External Quality Control Data 

(variables), 6-35 

F 

False Easting, 5-4 
False Northing, 5-4 
File Max Size option, 4-10, 4-13 
Format 

Computed data, 5-13 
Create (for computed data outputs 

& screens), 6-2 
DGNSS Data, 5-33 
GPS data, 5-15, 5-17 

Notation (fixed, free), 6-3 
Pseudoranges, 5-15 
Screen, 5-18 

Freq 1 (Hz), 5-28 

G 

GEO, 5-1, 5-3, 5-9, 5-10, 5-34, 6-35, 
6-45, 6-46, 6-48 

GNSS Status (variables), 6-35 
GPS C/P Filter, 5-15 
GPS Data, 5-15 
Graphic Pane, 2-6 
Grid, 3-5, 3-13 

H 

Hardware protection, 1-5 
Health & A/S, 5-15 
HEXA, 6-10 
HOMING, 5-23 

I 

IF, 6-11 
Initial configuration, 2-1 
Iono-UTC, 5-15 

K 

KART_UHF, 5-33 
Kinematic data (variables), 6-39 

L 

Language, 5-18 
Lat Long Format, 5-18 
license file, 1-1 
Local date, 5-7 



ConfPack Reference Manual 
Index 

 i-3 

Local time, 5-7 
Log data from receiver, 4-9 
LRK_UHF, 5-33 

M 

Macros, 6-1, 6-13 
ALM, 6-15 
DTM, 6-18 
GGA, 6-19 
GLL, 6-21 
GRS, 6-23 
GSA, 6-24 
GST, 6-25 
GSV, 6-26 
RMC, 6-27 
VTG, 6-29 
ZDA, 6-30 

MANPW, 5-26 
Maximum Dop, 5-10 
Minimum elevation, 5-6 
Mobile receiver, position for LRK 

initialisation, 5-6 
Mode 

Process cell and system cell, 5-8 
Mode (DGNSS), 5-30 
Modulation, 5-28 
Move 

Map, 3-8 

N 

NMEA0183, 6-1, 6-15, 6-18, 6-19, 6-
21, 6-23, 6-24, 6-25, 6-26, 6-27, 6-
29, 6-30 

North, 5-18 

O 

Operators, 6-6 
Options 

Communications, Automatic, 2-14 
Communications, Manual, 2-15 
Screen type, 2-13 
Timeout, 2-13 
Viewing, on World Map, 3-21 

Output Mode 
Computed data, 5-12 
DGNSS data, 5-32 
Pseudoranges, 5-14 

P 

Period (XMTR), 5-30 
Position Data (variables), 6-31 
Position status (variables), 6-32 
POSITION, Navigation mode, 5-22 
Power Mode, 5-26 
PRC Time Out, 5-31 
Process cell, 5-8 
PROFILE, 5-24 
Program folder, 1-3 
Programmable GPS Recorder option, 

4-12 
Proj. Kind, 5-3 
Pseudoranges, 5-14 

Q 

Quality Control, 5-1, 5-10 
Quit Conf Pack, 3-22 

R 

Range, 5-28 
Raw directory, 1-4 



ConfPack Reference Manual 
Index 

i-4  

Recording indicator (sessions), 5-25 
Registration, 1-3 
Remove 

template, 3-4 
Re-size 

Display pane, 4-16 
Map, 3-7, 3-8 
Panes, 2-6 
world map, 3-18 
World Map, 3-19 

Restore 
Port settings, 2-17 

Rotate globe, 3-18 
Routes, 5-21 

Create, 3-11 
Delete, 3-12 

RTCM numeric, 5-33 

S 

Saving port settings, 2-16 
Scale or Ref Lat., 5-4 
Select 

Region on World Map, 3-20 
Select Pane, 2-5 
Select/unselect 

modules and submodules, 2-5 
Modules and submodules, 2-7 

Sessions 
Description, 5-25 
Sequencing, 5-26 

Set directory, 1-4 
shortcut, 1-4 
Show/Hide 

Modules and submodules, 2-7 
SIGN, 6-11 
Simple GPS Recorder option, 4-10 
Simulation, 2-12, 2-17 

Skew or South Lat., 5-4 
Slot (XMTR), 5-30 
Software protection, 1-6 
Spaces (leading), 6-4 
Speed Data (variables), 6-32 
Speed Filter Time Constant, 5-7 
Stanag, 5-5 
Station ID (RCVR), 5-30 
Station Type, 5-33 
SVAR!D, 5-33 
System cell, 5-9 

T 

Templates, 3-3 
Time Data (variables), 6-31 
Time zone, 5-7 
Tpl directory, 1-4, 3-4 
TXT, 6-12 

U 

Unit number, 4-2 
Update 

Edit Pane, 2-5 
USERS_DATA, 5-33 

V 

Variable 
terminology, 6-1 

Variables 
Anomalies & alarms, 6-44 
Exhaustive list, 6-31 
tab, 2-17 

View 
Open configuration file, 3-22 



ConfPack Reference Manual 
Index 

 i-5 

W 

WAAS \ EGNOS Data, 5-35 
Waypoints, 5-19 

Create, 3-9 
Delete, 3-10 
Import, 3-10 

Win Comm, 1-4, 4-1, 4-5, 4-6, 4-9, 
4-16, 7-3 

Working Mode, 5-22 
Working Mode (sessions), 5-26 
World Map Editor, 3-17 

Z 

ZERO, 6-12 

 



 

 

 

 
 

 
 
 
 
 

 
 

ZAC de la Fleuriaye B.P. 433 
44474 CARQUEFOU Cedex 

Tel +33 (0)2 28 09 38 00 
 Fax +33 (0)2 40 09 39 39 

Web site: www.thales-navigation.com 
S.A. à Directoire et Conseil de surveillance 

au capital de 5 000 000 F 

321 391 237 RCS Nantes 
 


	Installation
	Introduction
	Protection
	Computer requirements
	Installation procedure from the CD-ROM
	Installation procedure from a set of 3¼" diskettes
	Running Conf Pack for the first time
	If you chose the hardware protection option
	If you chose the software protection option


	Introduction
	Configurations stored in GNSS receivers
	Introduction to Conf Pack
	How a configuration file is shown with Conf Pack
	Using the Select Pane
	Using the Edit Pane
	Using the Graphic Pane
	Changing the Options of Conf Pack


	Creating files with Conf Pack
	Creating a new configuration file
	Creating a new configuration template
	About templates
	How to create a new template
	How to remove a template from the New dialog box

	Copying all the data from an open configuration file to another open file
	Defining waypoints and routes with a simple click of the mouse
	Defining the region where to place your waypoints using the World Map editor
	Zooming in
	Zooming out
	Moving the map within the Graphic pane
	Adjusting the Zoom so as to view all the waypoints
	Placing waypoints on the map
	Importing waypoints from the 3SPack software
	Defining routes on the map

	Defining beacons with a simple click of the mouse
	Placing beacons on the map

	Using the World Map Editor
	Defining your work region using the World Map editor
	Rotating the globe
	Zooming in
	Zooming out
	Selecting a region on the World Map
	Changing the viewing options of the World Map

	Viewing the resulting configuration file
	How to quit Conf Pack

	Using Conf Pack connected to a THALES GNSS receiver
	Preliminary steps
	Writing a configuration into a receiver
	Reading the currently used configuration from a receiver
	Reading the initial configuration from a receiver
	Sending commands to a receiver
	Adding new commands to the combo box
	Using the Commands Editor dialog box

	Logging data sent by the receiver
	Simple GPS recorder
	Programmable GPS recorder

	Display Pane / Window
	Loading a new geoid

	Complete description of the nine modules of Configuration Parameters
	Modules and sub-modules
	DESCRIPTION
	GEODETIC SYSTEMS
	Coordinate Systems
	Current
	Altitude

	PROCESS
	Satellites
	Reference Position
	Time
	Filter
	Main Mode
	Maximum DOP
	Quality Control

	INPUT / OUTPUT
	Communications
	Formats
	Computed Data
	Pseudoranges
	GPS Data
	Bit flow
	Event Time Mark

	SCREEN
	Appearance
	Preferences

	NAVIGATION
	Waypoints
	Routes
	Mode

	SESSIONS
	Description
	Sequencing

	DGNSS
	Beacons
	Mode
	PRCs Time Out
	DGNSS data

	WAAS \ EGNOS
	Mode
	Data


	Programming Instructions for the design of screens and data outputs
	Terminology
	Creating formats
	General expression
	Possible notations
	Numerals
	Leading spaces
	Control characters
	Overflow condition

	Operators
	Operators list
	More about some the available operators

	Macros
	Macros list
	Syntax
	ALM:n:d
	DTM:n:d
	GGA:n:d
	GLL:n:d
	GRS:n:d
	GSA:n:d
	GST:n:d
	GSV:n:d
	RMC:n:d
	VTG:n:d
	ZDA:n:d

	Variables
	Time Data
	Position Data
	Speed Data
	Position status
	External Integrity Control
	GNSS Status
	DGPS Status
	Current Position
	Kinematic Data
	Station Data
	"Intermediate" Points Data
	Anomalies & Alarms
	Other Variables


	Review of the Conf Pack Commands
	File menu
	Edit menu
	View menu
	Transfer menu
	Tools menu
	Window menu
	Help menu


